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Preface 

Your Tektronix AWG4162 Arbitrary Waveform Generator is a convergent waveform generator with full 

function AFG (Basic) and AWG (Advanced) modes. Basic mode supports basic arbitrary and function 

waveform generation. Advanced mode has an adjustable sampling rate and supports both DDS mode and 

arbitrary mode generation, each of which supports sequence, continuous, gated, and trigger modes. 

This document describes the Basic Application mode operation. 

Documentation 
The following table lists related documentation available for your AWG4162. The documentation is 

available on the Tektronix Web site (www.tek.com/manuals). 

Item Purpose Location 

Compliance and Safety 

Instructions 

Compliance, safety, and basic 

installation information 

Printed and shipped with 

your instrument 

Advanced Application 

Help 

Advanced Application operating 

information 

On instrument and 

available as a PDF 

Basic Application Help Basic Application operating 

information 

On instrument and 

available as a PDF 

Programmer Manual Programming syntax and command 

information for remotely controlling 

the instrument 

Available as a PDF 

Service Manual 

Instrument servicing procedures and 

replaceable parts list Available as a PDF 

Specifications and 

Performance Verification 

Technical Reference 

Instrument specifications and 

performance verification procedures 

Available as a PDF 

Declassification and 

Security Instructions 

Describes how to sanitize, secure, and 

declassify the instrument Available as a PDF 

http://www.tek.com/manuals
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Getting Started 

General Features 

 Two working modes

o Basic (DDS) mode

 Two analog channels

 600 MHz sine waveforms

 2.5 GS/s, 14-bit, 16 kpts arbitrary waveforms

 Amplitude up to 5 Vp-p into 50 Ω load

o Advanced (Arbitrary) mode

 Two analog channels

 16/32-bit digital channels (optional)

 1/16/32/64 Mpts per channel arbitrary waveform memory (optional)

 Up to 750 MHz bandwidth

 SFDR < -60 dBc

 Variable sampling rate range from 100 S/s to 2.5 GS/s, with 14-bit vertical resolution, ensures signal

integrity in all aspects

 Designed for 100% user-conducted upgrades and configurations, all options activated through SW key

o Optional and upgradable arbitrary waveform memory up to 64 Mpts for each analog channel and

32 Mbit for each digital channel for long waveforms

o Optional 16-32 channel digital outputs. Purchasing SW option includes the shipment of digital

probe accessory.

 Dual analog channels and up to 32-bit digital channels, ideal for mixed signal circuit designs

 Sync-in and Sync-out interfaces enables the synchronization of multiple units in a daisy chain, to

extend the number of output channels

 Digital outputs provide up to 1.25 Gb/s data rate creates high speed digital pattern in parallel

 One marker out for each analog channel for triggering and synchronization

 Three software-configurable output paths fit all test cases

o Direct DAC mode: 750 MHz bandwidth with differential output

o AC coupled mode: 750 MHz bandwidth with single ended output for RF applications

o Amplified mode: 5 Vp-p amplitude 400 MHz bandwidth with differential output

 Full functional sequence with up to 16384 user defined waveforms provides the possibility of

generating complex signals with the best memory usage, in the form of loops, jumps, and conditional

branches

 Channel 1 and 2 (together with the corresponding digital output channels) can work independently on

different sampling clocks and sequences

 Direct communication with RFXpress® for easy waveform generation in RF applications

 Windows based platform with 10.1-in touch screen, front panel buttons, keyboard, and mouse

 Compact form factor, convenient for bench top and portability Removable hard disk guarantees the

security of confidential data

 USB 3.0 and LAN interfaces for remote control
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Operating Requirements

Power Supply 

Source Voltage and Frequency 100 to 240 V RMS@ 50-60Hz 

115VRMS@400Hz 
Characteristic condition Min. Nom. Max. Units 

Voltage 
Amplitude 

45-66Hertz 85 100-240 264 VRMS 

360-440 Hertz 100 115 132 VRMS 

Voltage Wave 
shape 

All Sine 

Power Consumption Maximum: 150W 
Measured: 125W 

Surge Current 30 A peak (25°C) for  5 line cycles, after product has been 
turned off for at least 30 s. 

Mechanical Characteristics 

Net Weight 14.2lbs (6.5 kg) 

Net Weight with Package 25.2lbs (11.5kg) 

Overall Dimensions Height: 233 mm 
Width: 439 mm 
Depth: 199 mm 

Dimensions with Package Height: 498 mm 
Width: 457 mm 
Depth: 574 mm 

Clearance The clearance requirement for adequate cooling is 2.0 in 
(50.8mm) on the left side (when looking at the front of the 
instrument) and on the rear of the instrument. 

Environmental Characteristics 

Temperature Operating +5 °C to +50 °C (+41 °F to 122 °F) 

Non-operating -20 °C to +60 °C (-4 °F to 140 °F) 

Humidity Operating 8% to 90% relative humidity with a maximum wet 

bulb temperature of 29 °C at or below +50 °C, non-condensing 

Non-operating 5% to 98% relative humidity with a maximum 

wet bulb temperature of 40 °C at or below +60 °C, non-

condensing 

Altitude Operating 3,000 m (9,843 feet) 

Non-operating 12,000 m (39,370 feet) 
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Standard Accessories 

Item Description TPN 

Manual COMPLIANCE AND SAFETY 

INSTRUCTIONS 

071345100 

Product CD Document CD with Browser Including the 

PDF files of Specs & PV Tech Ref, user 

manual, programmer, service manual.  

063457000 

ArbExpress Application S/W and Instructions 063376310 

Power Cable - 

USB cable - 174440100 

Stylus For touch panel 119610700 

Front protect cover - 200513000 

Accessory Pouch - 016202900 

50Ω SMA Terminator Male, DC-18GHz; 1 ea / channel 136716200 

Certification of Calibration - 001138701 

Tree year warranty - 

Recommended Accessories 

Item Description TPN 

Pin Header SMA Cable 45 inch 174619300 

RMD5000 - Rack mount kit

- Instruction sheet (English)

RMD5000 

Manual Service (English) 

Specs & PV Tech Ref 

Programmer manual 

077-1199-00 

077-1197-00 

077-1198-00 

AWG4HDDE - Hard disk drive AWG4HDDE 

SMA terminator 50 Ω 136716200 

AWG4SYNC Sync cable; Used for multiple instruments 

synchronization 

AWG4SYNC 

RFX100 RFXpress software RFX100 

AWG4DIG16LVDS 16-bit digital output cable; Used for LVDS AWG4DIG16LVDS 

AWG4DIGSCKT Digital output connector; AWG4k Digital 

Channel Connector on DUT (Amphenol, 

U65-B12-40E0C) 

AWG4DIGSCKT 

TEK-USB-488 GPIB to USB adaptor TEK-USB-488 

HCTEK54 Hard transit case HCTEK54 
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Power the Instrument On and Off 

Power On 

 Insert the AC power cord into the power receptacle on the rear panel.

 Use the front-panel power button to power on the instrument.

 Wait until the system shows windows desktop.

 You have two selections to open the applications:

You can press  or  button on front panel to launch one application. You can also click 

the shortcut icon  or  on desktop to launch any one of them.  

NOTE.  Only one application can be launched at a time. If you want to launch the other application, first 

close the one in use. 

Power Off 

 Close the application in use.

 Press the front-panel power button  to power off the instrument. 

You can also use the Windows menu to shut down the instrument. 

Protect Your Instrument from Misuse 

Check Input and Output Connectors 

When connecting a cable, be sure to distinguish the input connector from the output connectors to avoid 
making the wrong connection. 
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The instrument has both input and output connectors on the front panel. When connecting a cable, be sure 

to distinguish the input connectors from the output connectors. 

CAUTION.  Do not short output pins or apply external voltages to Output connectors. The instrument 

may be damaged. 

CAUTION.  Do not apply excessive inputs over +10 V to Trigger Input connector. The instrument may be 

damaged.

Obtaining the Latest Application and Version Releases 

The latest version of an optional application that you ordered with your instrument may not be installed 

on your instrument. The following download location is a fast and easy way to get the latest software 

version. 

To download the latest version of software, go to the home page of the Tektronix Web site 

(www.tek.com), and locate the Downloads section on that page. Enter the application name in the Search 

text box, and select Software in the Select Download Type pull-down menu. 

To define the search criteria, use the title of the application in the Search text box. For example, use the 

keyword AWG4162 to search for and download the latest version of AWG4162 software. 

Install Basic APP 

If your instrument has already installed another version of Basic APP, you must first uninstall it. You can 

find uninstall details in the “Uninstall Basic APP” section. 

1. Download Basic APP setup package from Tektronix website and decompress it to instrument’s local

disk.

CAUTION.  For differential analog output when one connector is used as single-ended output, another 
connector should be terminated with a 50 Ω terminator.

http://www.tek.com/
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2. Double click setup.exe to start the install. When you  see the welcome page click Next.

3. Select accept on the License Agreement page and then click Next.
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4. Press Install to start installation.

5. Installation will begin and the instrument will show installation progress.
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6. When “Installation Complete” appears, press Finish to restart the instrument. 
 

 
 

 

Uninstall Basic APP 
 

You can use Basic APP setup package to uninstall the Basic App in following steps.  
 

1. Download Basic APP setup package and decompress to instrument’s local disk.  
 

2. Double click setup.exe. The welcome dialog notices you to remove installed version Basic. Select 

“Yes” to start uninstallation. 
 



Uninstall Basic APP Getting Started 

AWG4162 Basic Application Help Document 10 

 

 

 

 

 
 

3. Uninstallation begins, instrument shows progress and exit automatically. 
 

 

Besides using setup package, you can also use Windows Control Panel tool to do Basic APP uninstallation 

by followed steps: 
 

1. Enter uninstall page through path: Start  Control Panel   Uninstall a program 
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Remote Control Getting Started  

 

 

 

2. In Uninstall or change a program page, please select “AWG4000 Basic” program, and uninstall it.  
 

3. Wait until uninstall is finished.  

 

 

Remote Control  
 

You can connect your instrument to a network for printing, file sharing, and Internet access, among other 

functions. Consult with your network administrator and use the standard Windows utilities to configure the 

instrument for your network. For LAN configuration, use the LAN Configuration dialog box from control 

panel. 

 

The instrument can be controlled using VXI-11 (LAN) or USBTMC protocols. It allows you to control the 

instrument remotely by using SCPI commands. Please refer to the AWG4162 programmer manual for a 

complete description about all available commands. You can follow the next steps to communicate with 

your AWG4162 instrument: 
 

1. Connect your LAN cable or USB to the instrument. 
 

2. On the Client-PC (IP Address)or AWG4162(LocalHost), launch the Tek OpenChoice Instrument 

Manager window. 
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Remote Control Getting Started  

 

 

 

3. Press Search Criteria… button  and enable LAN and USB. Input IP Address if on Client-

PC or LocalHost if on AWG4162 into Hostname, then press Search for searching optionally. You can 

also enable Auto Discovery for searching all the available instruments connected in LAN. Then press 

Done.  
 

 
 

4. Check the Instruments list to verify if the AWG4162 has been correctly detected. 
 

 
 

5. Press the Start Application or Utility button  to open OpenChoice Talker Listener and 
send a *IDN? Command. 
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6. The instrument should respond like this: 
 

TEKTRONIX,AWG4162Basic,C0000012,SCPI:99.0,FV:1.0, where C0000012 is the serial number 

and FV:1.0 is the Application version. 
 

7. You can also load an exist script to run in TekVISA. Please see TekVISA Talk/Listener help for more 

details. 
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Overheat Protection  
 

The instrument internal temperature is monitored in AWG4162. A warning message will appear if the 

internal temperature reaches a threshold level, and the instrument will automatically power off.  
 

 
 

 

If the warning message appears, check for following conditions: 
 

 The ambient temperature requirement is being met. 
 

 The required cooling clearance is being met. 
 

 The instrument fan is working properly. 
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Front Panel 
 

 
 

 

Rear Panel  
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Basic Application Overview 
 

 

Introduction to Basic Mode 
 

Running the AWG4162 in Basic mode allows you to easily generate function, pulse, and arbitrary 

waveforms. Select from 12 standard waveforms (Sine, Square, Ramp, Pulse, Sin(x)/x, Noise, DC, 

Gaussian, Lorentz, Exponential Rise, Exponential Decay, and Haversine). You can also create and save 

custom setups, define your own arbitrary waveforms, and create modulated waveforms. The following 

table shows the combination of modulation type and the shape of the output waveform. 
 

 
 

 
 
 
 
 
 

Run mode 

Sine, Square, 
Ramp, Arb, Sin(x)/x, 

Gaussian, Lorentz, 

Exponential Rise, 

Exponential Decay, 
Haversine Pulse Noise, DC 

Continuous X X X 

Modulation 

AM X 

FM X 

PM X 

FSK  X  

PSK X  

PWM X 

Sweep X 

Burst X X 
 
 
 

NOTE. When the instrument outputs an Arb waveform, Vp-p of instrument setup indicates the Vp-p value of 

normalized waveform data. When the instrument outputs Sin(x)/x, Gaussian, Lorentz, Exponential Rise, 

Exponential Decay, or Haversine, Vp-p is defined as twice the value of 0 to peak value. 
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Instrument Control 
 

This instrument has a graphical user interface with a flexible waveform edit function. It includes a display 

screen and touchscreen interface on a Microsoft Windows platform. 
 

You can control instrument operations using the following:  

Front-panel controls 

Menu bar commands 

Touchscreen 

Keyboard and mouse 

 

 

Touch-screen interface 
 

The touch screen interface is a standard feature of the instrument, which allows you to access menu items 

and on-screen controls with the touch of a finger. The Touch Screen Off button on the front panel enables 

or disables this function. 
 
 

Analysis and Connectivity Support 
 

This Tektronix Windows-based arbitrary waveform generator supports industry-standard software tools, 

applications and protocols. The integrated Windows desktop enables popular commercial programs or 

custom-written applications to run on the instrument. 
 

The instrument includes tools that you can install to support data import or export for use with data-analysis 

tools. The following tools are supported: 
 

TekVISA 
 

TekVISA is a library of industry-standard compliant software components, organized according to 

the standard VISA model established by the VXIplug&play Systems Alliance. Use TekVISA in 

software to write interoperable instrument drivers to handle communicating between software 

applications   and your instrument. 
 
 

VXI-11.2 LAN Server 
 

The VXI-11.2 LAN Server provides software connectivity between your instrument and remote PCs 

over an Ethernet LAN. This tool is a client-side component built-in with TekVISA on each remote PC, 

you must install another copy of TekVISA to make use of its client-side component. 

 

 

How to Start Basic Mode 
 

To start Basic mode, first power on the instrument and then push the Basic button  on the front 

panel to launch the Basic application. You can also click the Basic icon  on the desktop to launch.  
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Perform Instrument Self Calibration and Self Diagnostic 
 

The instrument performs a limited set of hardware tests at power-on. You can also perform the Self 
Calibration and Self Diagnostic from the System -> Tools menu.  

 

 
 

 

Self Calibration 
 

This calibration primarily checks DC accuracy using the internal calibration routines. 

 

CAUTION.  Do not power off the instrument while executing Self Calibration. If the power is turned off 

during Self Calibration, data stored in the internal memory may be lost. 
 
 

NOTE.  Before executing this operation, allow a 30 minute warm-up period after powering on the 

instrument, because the calibration is not valid if the instrument does not reach to a valid temperature. 
 

 

1. Click the System tab. 
 

2. Click the Tools tab from the left sidebar menu. 
 

3. Click the Warm up Timer, and one dialog will pop up to show warm up timer. Wait for 30 minutes. 

You can press Stop to terminate warming up. 
 

 
 

4. When 30 minutes is shown on warm up timer dialog, press OK. Wait for about 1 minute until system 

is not busy. 
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5. Click the Self Calibration button and the following dialog will appear. 
 

 
 

6. Select OK to run the calibration if you have warmed up for 30 minutes, or select Cancel to cancel the 

operation. Self Calibration may take for more than 20 minutes. It can’t be stopped during this 

operation. 
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Basic Application Overview Self Diagnostic 

 

 

 
 

7. When the Self Calibration is complete, results are displayed in the Information section of the display 

under Last Calibration. The log file location is also shown. 
 

 
 
 

Self Diagnostic 
 

This test verifies that your instrument is operating correctly. 
 

 

NOTE.  Before executing this operation, allow a 30 minute warm-up period after powering on the 

instrument, because the calibration is not valid if the instrument does not reach to a valid temperature. 
 

 

1. Click the System tab. 
 

2. Click the Tools tab from the left sidebar menu. 
 

3. Click the Warm up Timer, and one dialog will pop up to show warm up timer. Wait for 30 minutes. 

You can press Stop to terminate warming up. 
 

 
 



Basic Application Overview Self Diagnostic 

AWG4162 Basic Application Help Document 21 

 

 

 

 

4. When 30 minutes is shown on warm up timer dialog, press OK, Wait for about 1minute until system is 

not busy. 
 

 
 

5. Click the Self Diagnostic button and the following dialog will appear. 
 

 
 

6. Select OK to do the diagnostic if you have warm up for 30 minutes, or select Cancel to cancel the 

operation.  
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Basic Application Overview Protect Your DUT from Damage 
 

 

 

 

7. If diagnostics complete without any errors, the message Passed is displayed in the Information 

section of the display under Last Diagnostic. The log file location is also shown. 
 

 
 

 

Quick tips 
 

Allow a 30 minute warm-up period before executing Self Calibration or Self Diagnostic. 
 

Disconnect all the cables from the instrument when you perform Self Calibration or Self Diagnostic.  
 

It is recommended that the Self Calibration should be performed along with a periodic check. 
 

If you need to verify that the instrument meets the warranted specifications, do the complete set of 

performance verification procedures provided in the Specifications and Performance Verification 

technical reference manual. 
 

The Self Calibration will take about 20 minutes. The Self Diagnostic will take about 10 minutes. 

These operations cannot be stopped. 
 

Don’t power off the instrument during the Self Calibration or Self Diagnostic operations. 
 
 

Protect Your DUT from Damage 
 

Use care when you connect the instrument Channel Out to your DUT (device under test). To avoid 

damage to your DUT, the following preventive measures are provided. Follow these steps to set the 

limit values for high level and low level. 
 

1. Click the System tab and then click the Setting tab from the left sidebar menu. 
 

2. In this example, High Limit is set to 2.500 V, and Low Limit is set to -2.500 V. 
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3. Enter 50 mV for High Limit, and –50 mV for Low Limit. 
 

 
 

4. Select the front-panel Sine button  to display the waveform parameter. Confirm that High 

and Low voltage levels were changed. 
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NOTE.  You cannot enter any values greater than 50 mV for High level. 

 
 

Load Impedance, VOCM and the Output Window 
 

The following table shows the output window (maximum and minimum levels) for a sine waveform when 

you change the load impedance and VOCM. Window includes Max DC VOCM (50 ohm load: +/- 2.5 

V/High Z load: +/- 5.0 V). It depends on the range of amplitude and VOCM. You can read more about load 

impedance in the Set up Load Impedance topic and VOCM in the Set up VOCM topic. 
 

 

Frequency 50ohm load, single-ended high Z load, single-ended 

1uHz ~ 350MH -5V~5V -10V~10V 

350MHz ~ 550MHz -4V~4V -8V~8V 

550MHz~600MHz -3.5~3.5V -7V~7V 
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Operating Basics 
 
 

Default Setup 
 

You can return Basic mode to its default settings by clicking the Default button  on the Home tab or the 

front-panel Default button . Please see Appendix for details. 
 
 
 

Quick tutorial: How to select a waveform and adjust parameters 
 

If you are a beginning user, you can follow the steps described here to get acquainted with how to select a 

waveform and adjust waveform parameters once the instrument is powered on and running in Basic mode. 

1. Connect the power cord, and then push the front-panel power on/off switch  to turn on the 

instrument. 

2. Connect the Analog Ch1 Out  of the instrument to the oscilloscope input with a cable. 

3. Select a waveform. In the image below, Sine  is selected. 

4. Select the run mode from the left sidebar menu. In the image below, Continuous  is selected. 

5. Push the Ch1 On button  to enable the output. 
  

6. Observe the sine waveform displayed on the oscilloscope screen. 
 

7. Use the front-panel shortcut buttons on the instrument to select a waveform parameter. We push 

Frequency/Period button  to select Frequency as a parameter to be changed.  

8. You can also set the Phase , Ampl (amplitude) , Offset , and Units. 

9. If you push the Frequency/Period button  twice, the parameter changes to Period. Similarly, 

you can change the Ampl button  to High and the Offset button  to Low. Through UI 

operation, you click on Freq button to change the parameter to Period. Similarly, you can click on 

Ampl button to High, and the Offset button to Low.  
 

     



Operating Basics Quick tutorial: How to generate a sine waveform 

AWG4162 Basic Application Help Document 26 

 

 

 
 

10. Change the waveform parameters using the numeric keypad  or soft keys, the general 

purpose knob and the arrow keys , touch screen, or, keyboard and mouse. 
 
 

Quick tips 
 

Make sure oscilloscope input impedance is set to 50Ω to observe the correct amplitude, offset or 

Vocm.  
 

 
 

 

Quick tutorial: How to generate a sine waveform 
 

If you are a beginning user, you can follow the steps described here to generate a continuous sine 

waveform once the instrument is powered on. 

1. Connect the power cord, and then push the front-panel power on/off switch  to turn on the 

instrument. 

2. Start Basic Mode. (See page: How to Start Basic Mode) 

3. Connect the Analog Ch1 Out  of the instrument to the oscilloscope input with a cable. 

4. Select the Sine function  from the top of the Home tab. 
 

5. Select the Continuous run mode from the left sidebar menu. 

6. Push the front-panel Ch1 On button  to enable the output. 
 

7. Observe the sine waveform displayed on the oscilloscope screen.
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8. To change the frequency, click the number field next to it. 
 

9. To change the frequency value, use the touch panel. For example, click on 2 using the soft keyboard, 

then click on Units or Enter to complete the entry. You can change the Amplitude, Phase, and Offset 

values in the same way. 
 

 
 

10. You can also change the frequency value using the numeric keypad, the general purpose knob and the 

arrow keys, or keyboard and mouse. 
 

 

Quick tips 
 

Use the front-panel shortcut buttons to quickly select a waveform parameter.  
 

When you specify a waveform parameter using the shortcut buttons or touch screen selection, an active 

parameter is displayed in green in the graph area. 
 

 

Generate a Continuous Waveform 
 

Continuous run mode sets the generator to continuously output the signal. This is the default run mode. 
 
 

Generate a Pulse Waveform 
 

1. Select the Pulse function  from the top of the Home tab. 
 

2. Select the Continuous run mode from the left sidebar menu. 
 

3. To change the frequency, click the number field next to it. 
 

4. Click on Duty to change the parameter to Width. 
 

5. Click on the number field next to Leading and Trailing. 
 

6. You can set the Lead Delay by clicking on the number field next to Delay and adjusting the parameter 

as needed. You can also select Lead Delay by pushing the Phase/Delay shortcut button .  

7. Push the front-panel Ch1 On button  to enable the output. 
 

8. Observe the pulse waveform displayed on the oscilloscope screen. 
 



Operating Basics Generate a Pulse Waveform 

AWG4162 Basic Application Help Document 28 
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Pulse waveform formulas 
 
 

The following formulas are applied to leading edge time, trailing edge time, pulse period, and pulse 

width of pulse waveforms. 
 
 

lEdge (Leading Edge Time) 

tEdge (Trailing Edge Time) 

 
 
 

Maximum leading edge time.  This value is the minimum of the three in each instance.  

 

Temp1 = 0.8 * 2.0 * width – tEdge; 
 

Temp2 = ( period – width ) * 0.8 * 2.0 – tEdge; 

Temp3 = 1000 s. 

Maximum trailing edge time.  This value is the minimum of the three in each instance.  

 

Temp1 = 0.8 * 2.0 * width – lEdge; 
 

Temp2 = ( period – width ) * 0.8 * 2.0 – lEdge; 

Temp3 = 1000 s. 



Operating Basics Generate an Arbitrary Waveform 

AWG4162 Basic Application Help Document 30 

33 

 

 
 

Generate an Arbitrary Waveform 
 

1. Select the Arb function  from the top of the Home tab. 

2. Select ArbBuffer  from the Arb drop down menu to recall a previous internal arbitrary 

waveform or select Arb  to recall a stored arbitrary waveform. 
 

 
 

3. You can also recall waveforms by pushing the front-panel Arb button . 
 

4. The default internal arbitrary waveform is Sine. 
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Generate Noise and DC 
 

1. Select the Noise function  by clicking on More  from the top of the Home tab. 
 

2. You can set waveform parameters for Noise. 

3. Select the DC  to display DC parameters.  
 

 
 

 
Quick tips 

 

You cannot modulate, sweep or burst noise or a DC waveform. 

 



Operating Basics Generate a Burst Waveform 

AWG4162 Basic Application Help Document 33 

33 

 

 
 

Generate a Burst Waveform 
 

The instrument can output a burst using standard waveforms such as sine, square, ramp, and pulse, or 

arbitrary waveforms. The instrument allows you to use triggered and gated burst modes as follows: 
 

 

To Generate a Triggered Burst Waveform 
 

A specified number (burst count) of waveform cycles is output when the instrument receives a trigger input 

from the internal trigger source, an external trigger source, a remote command, or the manual trigger button. 
 

1. Select the Pulse function  from the top of the Home tab. 
 

2. Select the Burst run mode from the left sidebar menu. 
 

3. Confirm that 1-Cycle, N-Cycles, or Inf-Cycles is selected which means triggered burst mode is 

enabled. To generate a double pulse, set the Mode to N-Cycles and the burst count to 2. 
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4. An example of a double pulse and a trigger output signal is shown as below 
 

 
 

To Generate a Gated Burst Waveform 
 

This outputs a continuous waveform when an effective gate signal is applied externally, when the manual 

trigger button is depressed, when a remote command is applied, or during 50% of the selected internal 

trigger interval. 

 

In the gated burst mode, the output is enabled or disabled based on the internal gate signal or an external 

signal applied to the front-panel Trigger Input connector. While the gate signal is true or the front-panel 

Force Trig button is pushed in, the instrument outputs a continuous waveform. 
 

1. Select the Burst run mode from the left sidebar menu. 
 

2. Select Gate in the Mode field which means gated burst mode is enabled. 
 

3. Select Manual from the Source drop down menu to enable the manual trigger. 
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4. Click on the Trigger button  or push the front-panel Force Trig button . 
 

5. Observe the gated burst waveform displayed on the oscilloscope screen. 

 
 

Quick tips 
 

Use the front-panel shortcut buttons to quickly select a waveform parameter. 
 

The instrument provides the following three trigger sources for Burst mode: 
 

Internal or external trigger signal. 
 

Manual trigger (Force trigger). 
 

Remote command. 
 

Once Gate is selected, burst count parameters are ignored. 
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Sweep a Waveform 
 

Sweep outputs a waveform with the output signal frequency varying in sweep type of Linear, 

Logarithm, Upstair, and User Defined. You can set the following Sweep parameters: 

 

Start frequency: the beginning value of the frequency sweep. 

Stop frequency: the end value of the frequency sweep. 

Sweep time: affects the length (time) of the measurement. 

Return time: the amount of time from Stop Frequency to Start Frequency. 
 

Center frequency: the frequency half way between the start and the stop frequencies. 

Frequency span: the boundary of the frequency display. 

Hold time: the amount of time that the frequency must remain stable after reaching the stop frequency. 
 
 
 
 

1. Select a waveform function from the top of the Home tab. 
 

2. Select the Sweep run mode from the left sidebar menu. 
 

3. Specify the Start frequency, Stop frequency, Sweep time, Hold time, and Return time, as desired. 

When you click on the Start frequency button, it toggles to the Center frequency. When you click on 

the Stop frequency button, it toggles to the Span frequency. 
 

4. Click on the sweep Mode field and select Trigger or Repeat. 
 

5. Select the trigger source from the Source drop down menu. 
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6. This is a sample oscilloscope screen. The top is a sample of a sweep waveform. The bottom is a trigger 

output signal. 
 

 
 

Quick tips 
 

For frequency sweep, you can select a Sine, Square, Ramp, More, or Arbitrary waveform. Pulse, 

DC, and Noise waveforms cannot be selected. 

Once the sweep is selected, the frequency is swept from the sweep start to the sweep stop frequencies. 
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If a start frequency is lower than a stop frequency, the instrument sweeps from the low frequency to 

the high frequency. 
 

If a start frequency is higher than a stop frequency, the instrument sweeps from the high frequency 

to the low frequency. 
 

If you want to return to the Sweep menu after selecting other menus, push the front-panel Sweep 

button again. 

 

 

Modulate a Waveform 
 

To Output an AM Waveform 
 

Amplitude modulation (AM) is a technique that varies the amplitude of the carrier waveform. 
 

1. Select a waveform function from the top of the Home tab. This will be the carrier waveform. 
 

2. Select the Modulation run mode from the left sidebar menu. 
 

3. Specify the modulation type as AM by clicking on the Type field and selecting AM from the drop 

down menu. 
 

 
 

4. Select modulation source, set modulation frequency, select shape, and set modulation depth. 
 

5. This is an example amplitude modulation waveform displayed on an oscilloscope screen.  
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Quick Tips 
 

You can output frequency modulation (FM) or phase modulation (PM) waveforms in the same way. 

You cannot select Pulse, Noise, or DC as a carrier waveform. 
 

You can select an internal or external signal as an AM source. If you select an external source and set 
the modulation depth to 120%, the output will be at the maximum amplitude when a ±1 Vp-p signal 

is applied to the rear panel Ext Mod Ch1 In or Ext Mod Ch2 In connector. 
 

You can select a modulation shape from the internal memory or Local/USB memory. 
 

The following equations show the output amplitude of AM, FM, and PM modulation (in this example, 

sine waveform is used for carrier waveform and modulation waveform): 
 
 

AM: Output(Vp-p)= (1 + )  

FM: Output(Vp-p) = 

PM: Output(Vp-p) = 
 
 

Carrier amplitude A [Vp-p] 

Carrier frequency fc [Hz] 

Modulation frequency fm [Hz] 

Time t [sec] 

AM Modulation depth M [%] 

FM Deviation D [Hz] 

PM Deviation P [degree] 
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The following table shows relationship between modulation depth and maximum amplitude for AM 

modulation waveform (internal modulation source is selected): 
 

Depth Maximum amplitude 

120% A (Vp-p) 

100% A (Vp-p) * 0.909 

50% A (Vp-p) * 0.682 

0% A (Vp-p) * 0.455 
 

 
 

To Output an FSK Waveform 
 

Frequency Shift Keying (FSK) modulation is a modulation technique that shifts the output signal frequency 

between two frequencies: the carrier frequency and hop frequency. The AWG4162 generates a phase 

continuous FSK signal. 
 

1. Follow the steps described in the To Output an AM Waveform procedure to display the 

modulation type drop down menu. (See Modulate a Waveform.) In this example, select FSK 

as the modulation type. 
 

2. The FSK parameter setting screen is displayed. Select Internal or External as FSK Source. 
 

3. If you select Internal, you can set the FSK Rate. If you select External, the FSK Rate is ignored. 
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4. Set Hop Frequency. Carrier waveform frequency shifts to the Hop frequency with the specified FSK 

rate, and then returns to the original frequency. 
 

 
 

To Output a PSK Waveform 
 

Phase Shift Keying (PSK) modulation is a modulation technique that shifts the output signal phase between 

two phases: the carrier phase and hop phase. 
 

1. Follow the steps described in the To Output an AM Waveform procedure to display the 

modulation type drop down menu. (See Modulate a Waveform.) In this example, select PSK 

as the modulation type. 
 

2. The PSK parameter setting screen is displayed. Select Internal or External as PSK Source. 
 

3. If you select Internal, you can set the PSK Frequency. If you select External, the PSK Frequency is 

ignored. 
 

 
 

4. Set Hop Phase. Carrier waveform phase shifts to the Hop Phase with the specified PSK Frequency, 

and then returns to the original phase. 
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To Output a PWM Waveform 
 

Follow these steps to output a PWM waveform. 

1. Select the Pulse function  from the top of the Home tab to display the pulse parameter setting 

screen. 
 

2. Select the Modulation run mode from the left sidebar menu and the modulation type will be specified 

as PWM automatically. Select the PWM Source.  
 

 
 

3. Set the PWM Frequency, select the Modulation Shape, and set the Deviation (pulse width deviation). 
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Marker Out 
 

The Marker out signal of the instrument is linked to run mode and function selected in the two channels 

respectively. 
 

1. Connect the front-panel Marker out connector and the external Trigger Input connector of the 

oscilloscopes. The Marker out connector provides the trigger signal for oscilloscopes. 
 

 
 

2. Continuous mode: The Marker out is a square waveform and the rising edge at the start of each 

waveform period. When an output frequency is higher than 156.25 MHz, some restrictions are applied. 

See the Quick Tips below. 
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3. Sweep mode: When the Repeat or Trigger sweep mode and trigger source are selected, the Marker 

out is a square waveform and the rising edge at the start of each sweep. 

  

 
 

4. Modulation mode: When internal modulation source is selected, the Marker out is a square waveform 

of the same frequency as the modulating signal. When an external modulation source is selected, the 

Marker out is disabled. 
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5. Burst Mode: When internal trigger source is selected, the Marker out is a square waveform and the 

rising edge at the start of each burst period. When an external trigger source is selected, the Marker out 

is high during the time the trigger input is high. 
 

 
 

 

Quick Tips  
 

The relationship of frequency between Marker Out and Analog Output (AO):  
 

Start Frequency Stop Frequency Marker Frequency 

0 100 MHz Marker f = AO f 

100 MHz 200 MHz Marker f = AO f / 2 

200 MHz 400 MHz Marker f = AO f / 4 

400 MHz 600 MHz Marker f = AO f / 8 
 
 

NOTE. The maximum frequency of Marker Out signal is 156.25 MHz.  
   
 
 

NOTE. When the instrument outputs a modulation waveform, Marker Out signal cannot be output if 

you select External as the modulation source. 
  

 

 

The instrument provides the following three trigger sources for Burst mode: 
 

Internal or external trigger signal. 
 

Manual trigger (Force trigger). 
 

Remote command. 
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Adjusting Parameters of Two Channel Signals 
 

To Align Phase 
 

The AWG4162 uses a phase continuous method to change frequency. When you change a frequency of 

one channel, it will affect the phase relationship between the two channels. 
 

For example, the instrument is generating a 5 MHz sine waveform for both CH1 and CH2 and the phase is 

adjusted between the two channels. If you change the CH2 frequency to 10 MHz and then return it to 

5 MHz, the CH2 phase does not return to its initial condition. To adjust the phase relationship between 

the two channels, you need to stop signal generation and restart it. The instrument provides an Align 

Phase function to adjust the phase relationship. 
 

1. Set the instrument to generate a continuous sine wave at 5 MHz for CH1 and CH2. Confirm that both 

phases are set to 0 degrees. 
 

 
 

2. View both channels at once by clicking the CH1/CH2/CHBOTH button and selecting CHBOTH. 
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3. Change the CH1 frequency to 10 MHz, and then back to 5 MHz. In this state, the CH2 phase does not 

return to its initial condition.  
 

 
 

4. To align the phase of two channel signals, push the Inter-CHs button and select Align Phase. The 

instrument will stop signal generation, adjust the phases of both channels, and then automatically 

restart signal generation. 
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To Match Amplitude 
 

To set the CH1 amplitude and CH2 amplitude to the same level, follow these steps: 
 

1. To set both channels to the same amplitude, select the channel that has the desired amplitude. The 

selected channel will have a colored rectangle around it in the status area. 
 

 
 

2. Click the Inter-CHs button and select Amplitude CH1=CH2. The instrument will stop signal 

generation, set the amplitude of both channels to match the selected channel, and then automatically 

restart signal generation. 
 
 

To Match Frequency/Period 
 

To set the CH1 frequency and CH2 frequency to the same level, follow these steps: 
 

1. To set both channels to the same frequency, select the channel that has the desired frequency. The 

selected channel will have a colored rectangle around it in the status area. 
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2. Click the Inter-CHs button and select Frequency CH1=CH2. The instrument will stop signal 

generation, set the frequency of both channels to match the selected channel, and then automatically 

restart signal generation. 

 
 

Set up Load Impedance 
 

The output impedance of the AWG4162 is 50 Ω (in case of single-ended output). If you connect a load 

other than 50 Ω, the displayed Amplitude, Offset, and High/Low values are different from the output 

voltage. To make the displayed values same as output voltage, you need to set load impedance as follows: 
 

1. Select the System tab and then select Setting from the left sidebar menu. 

2. Click on Load in the desired channel to view the drop down menu. 
 

3. To adjust the load impedance, select one of the following: 
 

50 to set the load impedance to 50 Ω. 
 

High Z to set the load impedance to approximate to infinite. When dBm is specified for the output 

amplitude units, the amplitude units setting is automatically changed to Vpp if you select high. 
 

Custom allows you to set the load impedance to a value of 1 Ω to 1 MΩ. 
 

4. The load value is displayed in the Status menu. 
 
 

Quick tips 
 

Load impedance is applied to the amplitude, offset, high/low level, and VOCM settings. 
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Set up VOCM 
 

VOCM is “Voltage Output Common Mode” between + and – channels. In the case of differential output, 

the negative output DC VOCM is the same value of the DC VOCM of the positive output. 
 

1. Select the System tab and then select Setting from the left sidebar menu. 
 

2. Click on the number field next to the VOCM in the desired channel. 
 

 
Quick tips 

 

VOCM isn’t related to what amplitude setting. 
 

Maximum of VOCM is related to the load impedance as following: 

 AWG4162 

(50ohm load, single-ended) -2.5V ~ +2.5V 

(high Z load, single-ended) -5V ~ +5V 

 
 

Invert Waveform Polarity 
 

You can use the Invert button on the left sidebar menu to invert the polarity of a generated waveform. The 

following example shows how to get a differential signal using the invert function with a continuous sine 

wave. 
 

1. Set up the instrument to generate a continuous sine wave on CH1. 
 

2. Set the frequency of CH1 to a desired value. 
 

3. Click the CH1/CH2/CHBOTH button and select CHBOTH to view CH1 and CH2 simultaneously. 
 

4. Click on the Inter-CHs button and select Frequency CH1=CH2 to set the CH2 frequency to match 

CH1. 
 

5. Click CH2 in the CH2 status bar. 
 

6. Click on the Invert button on the left sidebar and notice that the CH2 waveform becomes inverted. 
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7. Push the front-panel Ch1 On button  to enable the output. 
 
 

Quick tips 
 

See the Quick tutorial: How to generate a sine waveform topic for a quick tutorial on getting started 

generating this waveform. 
 

See the Adjusting parameters of two channel signals topic to read about how to quickly set the 

frequency of one channel to match the other. 
 
 

Add Noise 

 

You can add the internal noise signal to a waveform using the following procedure. In this example, a 

continuous sine wave is used. 
 

1. Select the Sine function  from the top of the Home tab. 
 

2. Select the Continuous run mode from the left sidebar menu. 
 

3. Select the System tab and then select Setting from the left sidebar menu. 
 

4. Click on On/Off button next to Noise in the desired channel to turn on noise add function. 
 

5. Click on the number field next to the Noise parameter on the AWG4162 and adjust it as desired. Noise 

Level can’t be modified when Noise is Off. 
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6. Observe the waveform adding noise displayed on the oscilloscope screen. 
 

 
 

7. The top waveform is the one before adding noise. The bottom waveform is the one after adding noise. 

To avoid overflow by noise addition, the amplitude of the output signal is automatically halved. 
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Reference Clock Input 
 

1. The Reference Clock Input (Ref Clk In) and the Reference Clock Output (Ref Clk Out) connectors are 

provided on the AWG4162 rear panel. 
 

 
 

2. The instrument can use the internal or external source as a reference clock. To select a reference clock, 

push the front-panel Utility button  and then select Setting from the left sidebar menu. 
 

3. Click on Clock Ref to toggle between Internal and External. 
 

 
 

Quick Tips 
 

The instrument can use the internal source or an external source as a reference clock. When the internal 

reference is activated, a 10 MHz reference clock is output on the rear panel Ref Clk Out connector.  
 

When the reference clock input is activated, the rear panel Ref Clock Input connector is used as the 

input for an external reference clock.  
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Utility Menu 
 

 

Push the front-panel Utility button to display the System Tab. The System Tab provides access to utilities 

used by the instrument such as system related menus, Self Calibration, and Self Diagnostics. 
 

1. Push the front-panel Utility button  to display the System Tab. Select the Setting from the left 

sidebar menu to display the system related menus. 
 

2. Clock Ref. (See Reference Clock Input.) 
 

3. You can select the instrument Power On setting.  
 

4. You can modify the Ext Clock Rate if select Clock Ref source as External.  
 

5. Click on Beeper to toggle the beep sound Off and On.  
 

6. Click on Click Tone to toggle the click tone Off and On.  
 

7. You can modify High Limit and Low Limit for the desired channel.  
 

8. Load Impedance. (See Set up Load Impedance.) 
 

9. Noise. (See Add Noise.) 
 

10. VOCM. (See Set up VOCM.) 
 

Select the Status from the left sidebar menu to display the instrument status.  
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Select the Tools from the left sidebar menu.  
 

11. Warm Up Timer is used to calculate the warm up time.  
 

12. Self Calibration (See Perform Instrument Self Calibration and Self Diagnostic.) 
 

13. Self Diagnostic. (See Perform Instrument Self Calibration and Self Diagnostic.) 
 

14. You can copy the waveform parameter of one channel to another channel by clicking on Copy CH1 to 

CH2 or Copy CH2 to CH1.  
 

15. Secure. (See Erase Custom Waveform Files.) 
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Save/Recall a Custom Setup 
 

You can save up to four custom setups in the instrument internal memory. They are saved as Custom 1 

through 4 under the File tab. You can save more setups to the Local Disk or a USB memory device.  
 
 

Save a Custom Setup by UI 
 

1. Click the File tab. 
 

  
 

2. Click the desired Custom button which you want to save. 

3. Click the save icon  to save. 

 

 

Save a Custom Setup by Front Panel. 
 

1. Hold down the Custom1 button  in front panel file area.  
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2. A warning dialog will show if the custom1 file exist. 
 

 
 

3. Click Yes. 
 

4. An information dialog will show “Custom1 setup has been saved”. 
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Recall a Custom Setup by UI 
 

1. Click the File tab. 
 

2. Click the desired Custom button to view the waveform parameters and make sure it is the desired 

waveform. The parameters appear in the bottom half of the display. 
 

 
 

3. Click  to load the waveform file. You will now see the waveform on the AWG4162 display. 

 
 

Recall a Custom Setup by Front Panel 
 

1. Push the Custom1 button  in front panel file area.  
 

2. You will see the custom1 waveform display if custom1 exist. A warning dialog will show if the 

custom1 doesn’t exist. 
 
 

Quick tips 
 

Click  to lock a custom waveform file from being erased or edited. 

Click  to erase the selected custom waveform file. 

Click  to quickly navigate the four available custom files in the menu. 
 

Click  to open a custom waveform file. 

Click  to save a custom waveform file.
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Save/Recall a Custom Setup for Different User by UI 
 

1. Click the File tab.  
 

2. Click the desired User button to view the Recent Documents and Recent Places for different user. 

You can rename the User 1-9 by double click. 
 

 
 

 

Save a Screen Image 
 

You can save a screen image of the instrument. Do the following steps: 
 

1. Set the display to show the screen you want to save as image. Then simultaneously push the two arrow 

keys  underneath the rotary knob on the front panel. 
 

2. A message appears on the screen, indicating that the screen image was saved. 

 

 

Quick Tips 
 

Image files are saved in the path "D:\Tektronix\AWG4000\Basic" 
 

Image files are saved as .BMP format. The instrument gives all files created by the instrument the 

default name yyyy-mm-dd-hh-mm-ss.BMP. 
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Erase Custom Waveform Files 
 

Erase instrument setups and waveforms from memory 
 

You can also erase all instrument setups and waveforms from the instrument internal memory using the 

following procedure. 
 

 
NOTE.  You can restore the instrument to its default settings at any time without erasing memory by 

pressing the Default button located in the top right corner of the Basic mode display. 
 

 

1. Click the System tab. 
 

2. Click the Tools tab in the right sidebar menu. 
 

3. Click the Secure button and the following dialog will appear. 
 

 
 

4. Select OK to erase all setups and waveforms stored in hard drive X:\, or select Cancel to cancel the 

operation. 
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ArbBuilder 
 

You can create a waveform using the ArbBuilder tool. You can create new waveforms by selecting from 

a list of standard functions, using the Equation Editor (See Create a Waveform by Equation.), or drawing 

a waveform (See Draw a Waveform with ArbBuilder.). 
 

You can open ArbBuilder from the Home tab by selecting New  or Edit  from the 

drop down menu. 
 
 

 
 

 

Create a Standard Waveform 
 

1. Select ArbBuilder > New  or Edit  from the Home tab. 

2. Select New Std  from the Waveform tab. 

 
 

3. Select a standard waveform from the Function drop down menu. You can choose Sine, Square, 

Triangle, Pulse, Noise, DC, Exponential Rise, Exponential Decay, Sin(x)/x, Sweep, Multi Tone, 

Lorentz waveform. 
 

4. Adjust the vertical and horizontal parameters as desired. 
 

5. Click the Preview button to view the waveform. 
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6. Click the OK button to view the waveform, or click Cancel to cancel and exit the window. 

7. Click the SAVE button  or SAVE AS button  to save the waveform, or click Close button 

 to close the waveform. 
 

8. Click table to turn to communication page. 

9. Click Send to CH1  or Send to CH2  under communication tab to send this waveform 

to the channel 1 or channel 2. 

 
 

Create a Waveform by Equation 
 

You can generate a waveform by equation editor. You can use this function in the ArbBuilder tool. 
 

 
NOTE. The Equation editor processes all file inputs and outputs in the current working directory. The 

current working directory must have read and write access or the equation file will not compile. 
 

 

Equation Editor Overview 
 

The Equation editor is an ASCII text editor that allows you to create, edit, load, and compile equation 

waveform definitions into a waveform using the Waveform Programming Language (WPL). Use WPL to 

generate a waveform from a mathematical function, perform calculations between two or more waveform 

files, and use loop and conditional branch commands to generate waveform values. Compile the equation 

file to generate the described waveforms. 
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The equation editor processes all file inputs and outputs in the current working directory. The current 

working directory must have read and write access. Compilation may be dependent on the available 

memory and other resources of the instrument. 
 

An equation file is a text file that you create and edit in the equation editor. Select ArbBuilder > New 

 or Edit  Waveform tab and click the New Equa  icon to open the equation 

editor. 
 

 
 

The following table describes the screen elements of the equation editor. 
 

Element Description 

Toolbar Provides edit operations, such as open, save, cut, copy, and paste. 

File name The file name to which the equation or text is written, or the name of the file being 

edited. The instrument appends the default .equ file extension to all Equation editor 

files. 

Equation The area where you enter text and/or equation information. 

Output Displays the status of the compilation. If the compilation fails, then the application 

displays an error message. If the compilation is successful, then the application 
displays “Compiled Successfully”. 

Command List Keypad of math functions, numbers, and letters for creating equations. 

Preview Display of waveform graph after compile. 

Compile Button that compiles the currently loaded or edited equation file. The status of the 
compilation is displayed in the output window. 

Settings Provides controls for adjusting range and points. 

OK and Cancel buttons Use these buttons to save and exit (OK) or cancel and exit (Cancel) the Equation 

Editor window. 



Operating Basics Create a Waveform by Equation 

AWG4162 Basic Application Help Document 64 

33 

 

 
 

 
 

The component menu contains the items used to set the time range as well as functions, operators, variables, 

constants, syntax items and characters. You can use these items to create equations and enter comments. 
 

Component Symbol Meaning Example 

Syntax Items ( ) These are parentheses — (and) — for specifying 
the order of operations. Each opening (left) 
parenthesis must be paired with a closing (right) 
parenthesis. When there are two arguments – for 
example, range, max, min – they are separated 
with a , (comma).  

NA 

Variables. Here 
are the variables 
that can be used 
in an equation.  

t 
x 
v 

Time from the head of that range() statement 
Variable taking on a value from 0.0 to 1.0 within 
that range ( )  
Variable showing the current value of the waveform 
data at that position statement  

NA 

Operators +, –, *, / These add, subtract, multiply, or divide the 
components. The priorities are the same as usual 
for these four operators – * and / have priority over 
+ and –.  

NA 

^ Expresses exponents. Only integers can be raised 
to a higher power. ^ has the same priority as * and 
/. Therefore, parentheses are required to give 
priority to multiplication.  

pi * (2^3) * x where 2^3 = two raised 
to the third power.  

Comment # Comments are preceded by a number sign (#). 
When a number sign is entered, all characters after 
that until the end of the line are treated as a 
comment. All of the items in the component menu 
can be used in a comment.  

NA 

Characters a–z, %, $, &, 
@, A, _ 

The characters available in the component menu 
are the letters of the alphabet (a–z) and several 
symbols (%, $, &, @, A and _ ). These are used in 
comments.  

NA 
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Other items pi, e, k, =,   NA 

 pi The circumferential ratio. NA 

 
e Exponent (for an implied 10). The range for 

numbers expressed in this scientific notation is from 
|5.9e–39| to |3.4e38|.  

1e6=1,000,000, 1e–3=0.001 

 

k The k0–k9 can be specified; these are constants 
that may be used in equations. Specifying a new 
value for the same k# replaces the old value with 
the new one. If no constant  
is defined for k, this value will be automatically set 
to 0. 

NA 

 = Equals sign. = is used with k constants. k0=2*pi 

  

Ends the line for the range or equation; inserting a 
return  

( ) in the middle of the line partitions it.  

NA 

Functions sin(, cos( The arguments for these trigonometric functions are 
in radians. 

range(0,100 s)cos(2*pi*x) 
Example: 
range(0,100 s)sin(2*pi*1e4*t) 

 

exp(, log(, ln( Exponential function, common log function, natural 
log function. The log and ln arguments must be 
positive.  

range(0,50 _s) 
1–exp(–5*x) 
range(50 _s,100 _s) 
exp(–5*x) 
Example: range(0,100 _s) 
log(10*(x+0.1)) 
Example: range(0,100 _s) 
ln(2*(x+0.2)) 

 
sqrt( The square root; the argument must be a positive 

value. 
range(0,100 _s) 
sqrt(sin(pi*x)) 

 
abs( The absolute value. range(0,100 _s) 

abs(sin(2*pi*x)) 

 
int( Truncates the fraction to obtain the integer. range(0,100 _s) 

int(5*sin(2*pi*x))/5 

 
round( Rounds off the fraction to obtain the integer. range(0,100 _s) 

round(5*sin(2*pi*x))/5 

 

norm( Normalizes the range specified with range() and 
scales the amplitude values so that the maximum 
absolute value is 1.0 (that is, a value of +1.0 or –
1.0). The norm() statement comprises an entire 
line.  

range(0,100 _s) 
sin(2*pi*x)+rnd()/10 
norm() 

 
max( 
min( 

Takes the larger of two values. 
Takes the smaller of two values. 

range(0,100 _s) sin(2*pi*x) 
range(0,50 _s) min(v,0.5) range(50 
_s,100 _s) max(v,–0.5)  
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range( The equation must specify the time domain. If the 
time domain is not defined, this is an error. The 
time domain is specified with range().  
When making a new equation file, range(0, is input 
in the first line of equation. Next, the time is 
specified. This setting is valid until the next 
range( item is specified. With the first range() 
specification, any number of lines of equation  
can be input. Text written after the range() on the 
same line is invalid. Here is the format for the 
range( item.  
range( Equation starting time, Equation ending 
time ) 

range(0,1ms) Time range sin(2*pi*x) 
Equation  

 

rnd (integer 
from 1 to 
16,777,215) 

When an argument is specified, generates a 
random number sequence using that argument as 
the initial value. If the argument is omitted, 1 is 
used.  

range(0,100 _s) 
rnd(2)/3 

 

diff( Differentiates the function over the range specified 
with range(). Specified with diff(). The diff() 
comprises an entire line.  

range(0,33 _s) 
–0.5 
range(33 _s,66 _s) 
0.5 
range(66 _s,100 _s) 
–0.5 
range(0,100 _s) 
diff() 

 

integ( Integrates the function over the range specified with 
range(). Specified with integ(). The integ() 
comprises an entire line. After integ(), specify 
normalization (norm()) as necessary.  

range(0,33 _s)  
–0.5 
range(33 _s,66 _s) 
0.5 
range(66 _s,100 _s) 
–0.5 
range(0,100 _s) 
integ() 
norm() 

 

mark (marker1 
or marker2) 

Sets the marker for the range set with range(). After 
compiling, there is no marker display, but the set 
marker can be verified with the waveform editor. 
The mark() statement comprises an entire line. For 
example, when mark(1) is input, nothing else can 
be input on that line.  

NA 
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Use the equation editor Units menu to specify the units for the parameters or variables used in the equation. 

The following table lists the units that you can use and their descriptions. 
 

Unit Meaning 

m milli (e– 3 )  

u micro (e– 6 )  

n nano (e– 9 )  

p pico (e– 12 )  

s second 

, comma separator 

K Kilo (e3)  

M Mega (e6)  

 

Use the selection menu to confirm, backspace, or clear the equation. The following table lists the units that 

you can use and their descriptions.  

Button Meaning 

Enter Confirms the selection and moves to the next line of the equation  

BKSP Backspaces over the last character. Works like the backspace key on the keyboard  

CLR Clears the entire equation 

  
 

Create a Waveform by Equation Editor 

1. Select ArbBuilder > Edit > Waveform tab and click the New Equa icon  to open the 

equation editor. 
 

 
 

2. In the Equation Editor window, enter text to form a waveform equation. For example, type 

“Log(w)” in equation input box. 
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3. Click Compile button to generator a waveform in the preview box. You will see “Compiled 

Successfully” information in the Output box and a log waveform display in the Preview box. If you 

enter an invalid equation, the Output Box will show error warning message and the error line in the 

equation input box will turn to red. 
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4. Click the OK button to display the waveform in editable mode, or click Cancel button to cancel the 

operation. 
 

5. You will see a log waveform. You can edit, save or send it to channel 1 or 2. 
 

 
 

 
NOTE.  The equation editor supports only the basic 7-bit ASCII character set. The maximum length of a 

single string is 256 characters, including spaces. Concatenate strings by entering a colon character (:) at the 

end of a line. The maximum length, that is, sum of all string lengths is 1000. 
 

 

Save a Waveform Equation 
 

1. Create a waveform equation by following step 1 – 3 in the “Create a waveform equation”. 

2. Click  button in the equation editor toolbar. 
 

3. A Windows save as dialog box will show up. Enter a filename and save. The equation file will be 

saved in the .eqa format file.  
 
 

Open an Equation File 
 

1. In the Equation Editor window, click  in the equation editor toolbar. 
 

2. Select an existing waveform equation file and click Open. 
 



Operating Basics Open a Waveform with ArbBuilder 

AWG4162 Basic Application Help Document 70 

33 

 

 
 

Edit an Equation File 
 

In the Equation Editor window, you can do the following to modify equations:  

Cut. Highlight the part of the equation you want to cut and then click this icon .  

Copy. Highlight the part of the equation you want to copy and then click this icon . 

Paste. Highlight the part of the equation you want to paste and then click this icon . 

Directly edit the text using a keyboard or the Command List keypad. 

 

Open a Waveform with ArbBuilder 
 

1. Select ArbBuilder > New or Edit to open the ArbBuilder tool. 

2. Select Open button  from the Waveform tab. 
 

3. The windows file open dialog box pop up. Please select an existing waveform file. ArbBuilder 

supports several formats of waveform, such as .wfm, .pat, .txt, .tfw and .isf. The formats supported by 

ArbBuilder. 
 

4. You can open the files with 5 methods: 

Open in New Tab: You can open the file in a new tab.  
 

Insert at the End: You can insert the new file at the end of current waveform. 
 

Insert at the Beginning: You can insert the new file at the beginning of current waveform. 
 

Insert at Active Cursor: There are two cursors on the waveform view. Click the cursor you want to 

insert new waveform. Then click OK, the new file at the cursor of current waveform. 
 

Replace between Cursors: There are two cursors on the waveform view. The new waveform will be 

inserted between the two cursors. 

 

 
 

5. Click OK, the file will be opened. 

http://www.baidu.com/link?url=OtcmKAVKiRikyAZUVrIOhOPo8hQ_hUD_-yGzV2lqRoecT9i7l-I2b7dz01YOk4iw4LJBHeXUmHumH4OJX9hgOOFIPy9F-Fpye8hszAoZKAi
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Draw a Waveform with ArbBuilder 
 

1. Open a waveform. You can open a standard waveform (See Create a Standard Waveform.). 
 

2. Click the Draw tab. 
 

3. Use the icons in the Draw toolbar to create your waveform. 
 

 
 Redo is used to restore the previous state. 

 Undo is used to restore the next state. 
 

 Zoom In is used to enlarge the waveform graph. 
 

 Zoom Out is used to shrink the waveform graph 
 

 
Horizontal Zoom In is used to enlarge the waveform graph in horizontal 
direction. 

 
 Fit To Window is used to restore the default state of waveform. 

 
 Move With Hand is used to move the waveform by hand. 

 

4. Freehand  means you can draw waveform on both horizontal and vertical points. Horizontal 

 means you can draw waveform on horizontal direction. Vertical  means you can draw 

waveform on vertical method. Point  means you can draw some points and the points can be 

interpolated in the way of linear, smooth or staircase. 
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5. If you select Point icon , then the Point Draw toolbar appears. You can click on the graph, 

select points and then use the toolbar icons to edit them. You can use tools in the following table. 

6. If you click Table icon , the Point Draw Table window will open. You can enter points 

directly into this table and click OK to save. You can Insert, Delete or Clear all the data points. 
 

 
 

 



Operating Basics Edit a Waveform with ArbBuilder 

AWG4162 Basic Application Help Document 73 

33 

 

 

 
 

7. You can select from the interpolation  menu and apply one of the three selections to the 

waveform. Linear: Points can be connected with straight line. Smooth: Points can be connected with 

smooth line. Staircase: Points can be connected with staircase. 
 
 

Edit a waveform with ArbBuilder 
 

 

1. Open a waveform. Please see Open a Waveform with ArbBuilder. 
 

  
 

2. Click ArbBuilder->Edit. You will see the edit toolbar. 
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3. Cut . It is used to cut a piece of waveform data between the two cursors. 
 

 

4. Copy . It is used to copy a piece of waveform data between the two cursors. The waveform will not 

be changed. 

5. Paste . If the Paste button is clicked, a dialog box is pop up. There are four paste options. 
 

 
 

Item Description 

Paste at the End Paste a waveform segment at the end of 

a waveform 

Paste at the Beginning Paste a waveform segment at the 

beginning of a waveform 

Paste at the Active Cursor Paste a waveform segment behind an 

active cursor. 

Replace between the Cursors Replace the waveform between the 

cursors by a waveform segment. 
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6. Math 

It is used to make an arithmetic for a waveform. The arithmetic contains four operations which are 

addition, subtraction, multiplication and division. When the Math button  is clicked, a dialog box 

is pop up. 

 

 
 

There are three kinds of math sources which are waveform library, scalar value and copy from 

clipboard. 

 

Item Description 

Waveform Library There are seven kinds of waveform which are Sine, 

Square, Triangle, Pulse, Noise, Exponential Rise, 

Exponential Decay. 

Scalar Value An amplitude value set by the user 

Copy from clipboard A piece of waveform from Copy or Cut operation. 
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7. Invert . It is used to overturn the waveform between the cursors in the vertical direction. 
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8. Mirror . It is used to overturn the waveform between the cursors in the horizontal direction. 
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9. Shift/Rotate . When the user clicks the Shift/Rotate button, a panel is pop up in the right of 

main panel zone. The waveform display zone will shrink. 
 

 
 

Item Description 

Points Set the point number which is moved each time 

Amplitude Set the amplitude which is moved each time 

Rotate Move the waveform periodically 

Horizontal Shift Move the waveform and use zero to fill the 

data after the waveform 

 

 Shift left is used to move the waveform left. 

 Shift right is used to move the waveform right. 

 Shift up is used to move the waveform up.  

 Shift down is used to move the waveform down. 

 Shift/Rotate can pop up a dialog and realize the shift/rotate function all the same. 
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Send a Waveform to CH1/CH2 
 

1. Click Communication in the ArbBuilder. 
 

 

2. Click Send to CH1  or Send to CH2 . You will see a progress bar. The waveform is sent 

to Basic. 
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Appendix  
 

Touch Panel Calibration 
 

1. Double click “Microchip AR Configuration Utility” on the desktop. 

2. Choose “Configuration Wizard”. 
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3. After click next will show below dialog, please choose “AR1100 Dev Kit”. 
 

 
 

4. After that it will show the dialog as below, please choose “USB” and “Digtizer”, and please wait. 
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5. Please click next until it shows below dialog, after that please click “Next”, and finished. 
 

 
 

6. Please close this application. 
 

7. Please double click “Microchip AR Configuration Utility” on the desktop again, and choose “Manual 
Setup”. 
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8. It will show below picture that let you click the plus to calibrate touch panel. 
 

 
 

9. After touch all the pluses , when it will show below picture means you can close application and 
complete the calibration. 
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Default Settings 
 

The following table lists the settings that are restored when you push the front-panel Default button or send 

SCPI command “*RST”. 
 

Menu or System  Default setting 

Output 

configuration 

Function Sine 

Frequency 1.000 000 000 00 MHz 

Amplitude 1.000 Vp-p 

Offset 0 mV 

Symmetry (Ramp) 50.0% 

Duty (Pulse) 50.0% 

Output Units Vp-p 

Output Impedance 50Ω 

Output Invert Off 

Output Noise Add Off 

Output High Limit  2.500 V 

Output Low Limit  -2.500 V 

VOCM 0 mV 

Modulation Modulation Waveform 10.00 kHz, Sine (except FSK,PSK) 

Modulation Waveform 10.00 kHz, Square (FSK,PSK) 

AM Depth 50.0% 

FM Deviation 1.000 000 MHz 

PM Deviation 90.0  

FSK Hop Frequency 1.000 000 MHz 

FSK Rate 10.000 000 0 kHz 

PWM Deviation 5.0% 

PSK Frequency  10.00 kHz 

PSK Hop Phase 90.0  

Sweep Sweep Start Frequency  100.000 kHz 

Sweep Stop Frequency  1.000 000 MHz 

Sweep Time  10 ms 

Sweep Hold Time  0 ms 

Sweep Return Time 1 ms 

Sweep Type  Linear 

Sweep Mode  Repeat 

Sweep Source Internal 

Trigger Slope Positive 

Trigger Interval  1.000 ms 

Input Threshold 0.00 V 

Step Num 1 

Burst Burst Mode  Triggered 

Burst Count  5 

Trigger Source  Internal 

Trigger Delay  0.0 ps 

Trigger Interval  1.000 000 ms 

Slope Positive 

Input Threshold 0.00 V 

Phase 0.00° 

System-related 

settings 

Clock Reference Internal 

Ext Clock Rate 10 MHz 
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Preface 
This document contains information about how to use the Advanced Application of the Tektronix AWG4162 Arbitrary 
Waveform Generator, along with basic operations and concepts. 

 

Documentation 
The following table lists related documentation available for your AWG4162. The documentation is available 
on the Document CD and on the Tektronix Web site (www.tektronix.com/manuals). 

 

Item Purpose Location 

Compliance and Safety 
Instructions 

Compliance, safety, and basic installation 
information 

Printed and 
shipped with 
your instrument 

Advanced Application Help 
Advanced Application operating 
information 

Instrument and 
available as a 
PDF at 
www.tek.com/ 
manuals 

Basic Application Help Basic Application operating information 

Instrument and 
available as a 
PDF at 
www.tek.com/ 
manuals 

Programmer Manual 

Programming syntax and command 
information for remotely controlling the 
instrument 

Instrument and 
available as a 
PDF at 
www.tek.com/ 
manuals 

Service Manual 
Instrument servicing procedures and 
replaceable parts list 

Instrument and 
available as a 
PDF at 
www.tek.com/ 
manuals 

Specifications and 
Performance Verification 
Technical Reference 

Instrument specifications and 
performance 
verification procedures 

Instrument and 
available as a 
PDF at 
www.tek.com/ 
manuals 

Declassification and Security 
Instructions 

Describes how to sanitize, secure, and 
declassify the instrument 

Instrument and 
available as a 
PDF at 
www.tek.com/ 
manuals 

 

http://www.tektronix.com/manuals
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Getting Started 

General Features 
 Two working modes 

o Basic (DDS) mode 
 Two analog channels 
 600 MHz sine waveforms 
 2.5 GS/s, 14-bit, 16 kpts arbitrary waveforms 
 Amplitude up to 5 Vp-p into 50 Ω load 

o Advanced (Arbitrary) mode 
 Two analog channels 
 16/32-bit digital channels (optional) 
 1/16/32/64 Mpts per channel arbitrary waveform memory (optional) 
 Up to 750 MHz bandwidth 
 SFDR < -60 dBc 

 Variable sampling rate range from 100 S/s to 2.5 GS/s, with 14-bit vertical resolution, ensures signal 

integrity in all aspects  

 Designed for 100% user-conducted upgrades and configurations, all options activated through SW 

key 

o Optional and upgradable arbitrary waveform memory up to 64 Mpts for each analog channel 

and 32 Mbit for each digital channel for long waveforms 

o Optional 16-32 channel digital outputs. Purchasing SW option includes the shipment of 

digital probe accessory. 

 Dual analog channels and up to 32-bit digital channels, ideal for mixed signal circuit designs 

 Sync-in and Sync-out interfaces enables the synchronization of multiple units in a daisy chain, to 

extend the number of output channels 

 Digital outputs provide up to 1.25 Gb/s data rate creates high speed digital pattern in parallel 

 One marker output for each analog channel for triggering and synchronization 

 Three software-configurable output paths fit all test cases 

o Direct DAC mode: 750 MHz bandwidth with differential output 

o AC coupled mode: 750 MHz bandwidth with single ended output for RF applications 

o Amplified mode: 5 Vp-p amplitude 400 MHz bandwidth with differential output 

 Full functional sequence with up to 16384 user defined waveforms provides the possibility of 

generating complex signals with the best memory usage, in the form of loops, jumps, and conditional 

branches 

 Channel 1 and 2 (together with the corresponding digital output channels) can work independently 

on different sampling clocks and sequences 

 Direct communication with RFXpress® for easy waveform generation in RF applications 

 Windows based platform with 10.1-in touch screen, front panel buttons,keyboard, and mouse 

 Compact form factor, convenient for bench top and portability Removable hard disk guarantees the 

security of confidential data 

 USB 3.0 and LAN interfaces for remote control 
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Operating Requirements 
 

Power supply 

Source voltage and frequency 100 to 240 Vrms @ 50 - 60 Hz 

115 Vrms @ 400 Hz 

Power consumption max 150 W 

Surge current 30 A peak (25 °C) for ≤ 5 line cycles, after product has been turned off for at least 30 s 

Physical characteristics 

Weight (typical) 

Net weight 6.5 kg (14.2 lbs) 

Net weight with packaging 11.5 kg (25.2 lbs) 

Dimensions 

Height 233 mm (9.17 in.) 

Width 439 mm (17.28 in.) 

Depth 199 mm (7.82 in.) 

Dimensions with packaging(typical) 

Height 498 mm (19.61 in.) 

Width 457 mm (17.99 in.) 

Depth 574 mm (22.60 in.) 

Clearance ≥50.8 mm (2.0 in.) on left and rear sides of the instrument 

Temperature 

Operating +5 °C to +50 °C (+41 °F to 122 °F) 

Non-operating -20 °C to +60 °C (-4 °F to 140 °F) 

Humidity 

Operating 8% to 90% relative humidity with a maximum wet bulb temperature of 29 °C at or below 

+50 °C, non-condensing 

Non-operating 5% to 98% relative humidity with a maximum wet bulb temperature of 40 °C at or below 

+60 °C, non-condensing 
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Altitude 

Operating 3,000 m (9,843 feet) 

Non-operating 12,000 m (39,370 feet) 
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Standard Accessories  

Item Description 

Manual  COMPLIANCE AND SAFETY INSTRUCTIONS 

Product CD  
Document CD with Browser Including the PDF files of 
Specs & PV Tech Ref, user manual, programmer, 
service manual.  

Power Cable  - 

USB cable - 

Stylus For touch panel 

Front protect 
cover 

- 

Accessory Pouch - 

50Ω SMA 
Terminator 

Male, DC-18GHz; 1 ea / channel 

Certification of 
Calibration 

- 

Three year 
warranty 

- 

 

Recommended Accessories  

Item Description 

Pin Header 
SMA Cable 

45 inch 

RMD5000 
- Rack mount kit  

- Instruction sheet (English) 

Manual 

Service (English) 

Specs & PV Tech Ref 

Programmer manual  

AWG4HDDE  - Hard disk drive 

SMA 
terminator 

50 Ω 



  

14 
 

AWG4SYNC  
Sync cable; Used for multiple instruments 
synchronization 

RFX100 RFXpress software 

AWG4DIG16LVDS  16-bit digital output cable; Used for LVDS  

AWG4DIG16TTL  
16-bit digital output adaptor; LVDS to 
TTL/CMOS  

AWG4DIGSCKT  
Digital output connector; AWG4k Digital 
Channel Connector on DUT (Amphenol, U65-
B12-40E0C) 

TEK-USB-488 GPIB to USB adaptor 

HCTEK54 Hard transit case 

 

 

 

Powering the Instrument On and Off 
Power On 

1. Insert the AC power cord into the power receptacle on the rear panel. 
2. Use the front-panel power button to power on the instrument. 
3. Wait until the system shows windows desktop. 
4. You have two selections to open the applications: 

 
You can press the “Basic” or “Advanced” Buttons on front panel to launch one application. You can also click the shortcut 
icons on desktop to launch any one of them.  
  

NOTE:  

Only one application can be launched at same time. If you want to launch the other application, please close the 
first one at first. 

 

 

Power Off 
1. Please close the application that you are using at first. 
2. Use the front-panel power button to power off the instrument. 
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Protect Your Instrument from Misuse 
Check Input and Output connectors  

 

Figure 1 Output connectors 

The instrument has both input and output connectors on the front panel. When connecting a cable, 

be sure to distinguish the input connectors from the output connectors. 

No Hot Plugging 

 

Figure 2 Digital pods 

The instrument has two Digital Pods on the front panel and Sync In, Sync out connector on the rear 

panel. Please be noted: No Hot Plugging for these connectors when connecting a cable on these 

connectors. 
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Update Your Instrument Firmware  

Install Advanced APP 

If your instrument has already installed another version of Advanced APP, you must uninstall it 

firstly. You can find uninstall details in next section “Uninstall Advanced APP”. 

1. Download Advanced APP setup package from Tektronix website and decompress it to 

instrument’s local disk.  

2. Double click setup.exe, start to install. You will see the welcome page, press Next. 

  
Figure 3 Welcome page  
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3. Select the path that you want to install your application by pressing Browse button, choose the 

person who have the right to use the application, then click Next. 

 
Figure 4 Select installation folder 

 

4. Press Next to start installation. 
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Figure 5 Confirm installation 

 

5. Installation begins, instrument shows installation progress, please wait. 

 
Figure 6 Installation in progress  
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6. Wait until instrument shows “Installation Complete”, then press Close to finish the installation. 

 
Figure 7 Installation complete 

      Now you can find installed Advanced APP icon in the Start Menu and on the desktop.  
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Uninstall Advanced APP 

You can use Advanced APP setup package to uninstall the firmware in following steps: 

1. Download Advanced APP setup package and decompress to instrument’s local disk.  

2. Double click setup.exe. The welcome dialog notices you to select whether repair or remove 

installed version Advanced. Select “Remove AWG4000 Advanced” and press Finish to start 

uninstallation. 

  
 

Figure 8 Uninstalling firmware 
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3. Uninstallation begins, instrument shows installation progress, please wait. 

 
Figure 9 Uninstallation in progress 

4. Wait until instrument shows “Uninstallation Complete”, then press Close to finish the 

uninstallation. 

 

Besides using setup package, you can also use Windows Control Panel tool to do Advanced APP 

uninstallation by followed steps: 

1. Enter uninstall page through path: Start  Control Panel   Uninstall a program 
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Figure 10 Uninstall a program in control panel 
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2. In Uninstall or change a program page, please select “AWG4000 Advanced” program, and  

uninstall it.  

3. Wait until uninstall finished.  
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Remote Control  
You can connect your instrument to a network for printing, file sharing, Internet access, among 

other functions. Consult with your network administrator and use the standard Windows utilities to 

configure the instrument for your network. For LAN configuration, use the LAN Configuration dialog 

box from control panel. 

In addition, if the instrument is under remote mode, it allows you to control the instrument 

remotely by using SCPI commands. Please refer to the AWG4162 SCPI commands manuals for a 

complete description about all available channels. 

The instrument can be controlled using VGPIB, VXI-11 (LAN) or USBTMC protocols. You can follow 

the next steps to enable the servers and start to communicate with your AWG4162 instrument: 

1. Connect your LAN cable or USB to the instrument. 

2. Press the Remote/Local Mode button in the Utility Tab, as shown in the following figure.

 

Figure 11 Utility tab 

3. The VGPIB/LAN/USB-TMC configuration panel will open, as shown in the following figure. 

 

Figure 12 VGPIB/LAN/USB-TMC configuration panel 
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4. On the Client-PC launch the Tek OpenChoice Instrument Manager window , as shown in the 

following figure. 

 

Figure 13 OpenChoice Instrument Manager 

5. Press Search Criteria… button and enable VXI/LAB/USB/GPIB, as shown in the following 

figure. 

 

Figure 14 Search Criteria  
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7. Check the Instruments list to check the if the AWG4162 has been correctly detected. 

8. Press the Start Application button to open OpenChoice Talker Listener and send a *IDN? 

Command.  

  

Figure 15 OpenChoice Talker Listener  

9. The instrument should respond to the string: 

TEKTRONIX,AWG4162ADVANCED,CO000003,SCPI:99.0,FV:ARB 5.3 

where CO000003 is the serial number and ARB 5.3 is the firmware version. 
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11. You can check also the result in the Remote/Local form, as shown in the following figure. 

 

Figure 16 Result in the Remote/Local form  
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13. Using the OpenChoice Taker Listener window you can also load a script (SampleImport.txt) , 

as shown in the following figure. 

 

Figure 17 Load a script in OpenChoice Taker Listener 
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14. Press the Run button to run the script and send the SCPI commands to the instrument, as 

shown in the following figure. 

  

Figure 18 Run a script in OpenChoice Taker Listener 
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16. You can also check the SCPI commands in the Remote/Local form, as shown in the following 

figure. 

 

Figure 19 Check the SCPI commands in the Remote/Local form 

17. The instruments settings will be updated in the Channel AO1/ Channel AO2 tabs. 

 

Overheat Protection  
The instrument internal temperature is monitored in AWG4162. A warning message will appear if the internal temperature 

reaches a threshold level, and signal output will automatically turn off. If the warning message appears, check for following 

conditions: 

 The ambient temperature requirement is being met. 

 The required cooling clearance is being met. 

 The instrument fan is working properly. 
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Getting Acquainted with Your Instrument 

Front Panel Overview  

 

Figure 20 Front panel overview 
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Rear Panel  

 

Figure 21 Rear panel overview 
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Advanced UI Basics 
This chapter gives explanation of some basic concepts for the advanced UI functions: 

Sequence 
Sequencing is often used for two purposes 

a) To save memory space by repeating a single waveform stored in memory, instead of storing 

many copies in memory 

b) To generate a complex series of waveforms by means of loop, wait, jump when certain 

triggering events happen. 

A sequence contains a series of entries, in which a user can put a mixed waveform with 2 analog and 

32 digital waveforms in parallel. Users can program execution rules of each entry to define how they 

are executed in the sequence, including  

a) Wait Event – Entry waits to start until the event happens 

b) Repetition times 

b) Go to – the next entry after the entry repetition expires 

c) Jump Event – the next entry to jump to when the event happens, even repetition doesn’t expire 

 

Figure 22 Sequence 

Analog 

Waveform 

Digital 

Waveform 

Entries 
Sequence 

Window 
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Figure 23 Editing sequence 

SubSequence 
A subsequence is a combination of entries pre-defined by a user, which can be called and put in the 

main sequence just as an entry.  

Entry 
In Sequence mode, entry is used to set repetition and event parameters of every waveform element, 

every waveform element has one entry. 

Segment 

A Segment contains one or more Components, all of the same length, combined by means of the 

elementary Add, Subtract, Multiply operations. 

If one Segment contains more Components, the following formula will be applied: 

Segment = (Component1 (Add/Sub/Multiply)Component2) Add Component 3 Add Component 4 

Add Component N 

Component 

A Component is the basic element for the construction of a Segment. Each Component may be 

represented by a standard waveform (DC Level, Sine, Cosine, Exponential, Triangle, Rectangle, 

Ramp, Pulse, Sync, Sawtooth, Sweep), by a Formula, or its component samples can be loaded from a 

text file. 
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Workspace 
The AWG4162 software can manage the instrument as a powerful arbitrary waveform generator. 

The software is project based. There are two types of projects: Single Sequencer and Multi 

Sequencer. The two kinds of workspace differ in the way how the analog/digital resources are 

managed: 

Single Sequencer 
 In this workspace all analog/digital resources are managed synchronously, even when 

multiple boards are connected together in a daisy chain configuration. 

This mode is called “Single Sequencer” because there is only one sequencer which 

manages multiple output channels. 

Multi Sequencer 

 In this workspace each analog output can be configured independently from each other. 

Each analog output behaves as an independent device with a single output channel. 

This mode is called “Multi Sequencer” because each analog channel has its own 

sequencer. However, the channels can share trigger and synchronization signals, even if 

each channel is configured independently. 
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Digital Data 

The AWG4162 has up to 32 digital lines that can be configured as a powerful pattern generator. The 

available digital lines number depends on the Digital Option loaded by you. 

 

The digital bus can be configured in two modes:  

Low Speed Mode: 16 bits are available on PodA and PodB. The digital output sampling rate is ¼ of 

the analog sampling rate, so the length of the digital samples must be ¼ of the analog waveform 

length. 

High Speed Mode: 8 bits are available on PodA and PodB. The digital output sampling rate is ½ of the 

analog sampling rate, so the length of the digital samples must be ½ of the analog waveform length. 

 

If the digital option is not available, the user can modify in the Waveform Editor the digital lines Pod 

A DO(0) a nd Pod B DO (0). Those lines represent Marker 1 and Marker 2 output signals. 

 

The marker outputs sampling rate depends on the High Speed/Low Speed mode selection. 

The marker type can be analog or digital: 

 When the analog marker is selected, the signal comes from the front panel SMA and its 

maximum update rate is 156.25 MHz. 

 When the digital marker is selected, the marker is connected to the Digital Pod A/Pod B and 

it is available through the digital connector PIN.  

Note that  if there is no digital option, the marker is in high speed mode. In addition, with option 

DO16, Marker 2 speed will follow the speed set for Marker 1. 

 

Mixed (analog/digital) waveforms 
Since some constrains must be applied for only analog and digital waveforms in the same sequencer 

entry, it is suggested to work with mixed waveforms if not specified otherwise. 
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Advanced UI Introduction 

Start Page  

 

Figure 24 Start page 

When you start the Advanced APP, it enters Start Page first. The Start Page includes 3 areas: 

1. Recent Workspaces: 

List name of recent open workspaces. 

2. Getting Started: 

Press “Open Workspace” button can open one certain existed workspace. 

Press “New Workspace” button can create a new workspace. 

3. How do I 

In this area, it provides several simple examples, which help you to learn how to use 

Advanced APP.  
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Self-Diagnostic 

NOTE:  

Before performing this procedure, allow a 30 minute warm-up period after powering on the instrument, because 
the diagnostic is not valid if the instrument does not reach to a valid temperature. You can go to Basic 
application –> System -> Tools -> Warm Up Timer to do the warm-up. 

 

You can run the internal diagnostics using the Utility menu item.  

 

Figure 25 Utility menu 

Take the following procedures to run the internal diagnostics:  

1. Press The Diagnostic button  

2. The Diagnostic dialog box appears, as shown in the following figure. 

 

Figure 26 Diagnostic dialog box 

3. Click Start button to start the diagnostics.  

The diagnostics takes for about 10 minutes to complete. If diagnostic failure occurs, run 

self-calibration. If failures still exist, please contact your local Tektronix service person. 
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Self-Calibration 
Self-calibration uses internal calibration routines to check electrical characteristics such as 

DC Direct and DC AMP analog level/offset and then adjust the internal calibration constants 

if necessary.  

NOTE:  

Before performing this procedure, allow a 30 minute warm-up period after powering on the instrument, because 
the calibration is not valid if the instrument does not reach to a valid temperature. You can go to Basic 
application –> System -> Tools -> Warm Up Timer to do the warm-up. 

 

 
Figure 27 Utility menu 

 

Take the following procedures to do the self-calibration: 

1. Press The Self Calibration button   

2. The Self-calibration dialog box appears, as shown in the following figure. 

 

Figure 28 self-calibration dialog box 

3. Check the Verify box if you want to also verify the calibration parameters. 

4. Press Start. 

The calibration takes for about 10 minutes to complete. The message “Calibration 

process completed:SUCCESS” will pop up when the calibration finishes. If failure 

occurs, please contact your local Tektronix service person. 
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Home Page 
When you open an existing project or create a new one, the following figure is displayed.  

 

Figure 29 Project interface 

The numbered interface sections are explained as follows. 

1. Ribbon Menu Bar and Toolbar- provides menu access to device settings, utilities, and 
online help. 
 

 File: 

 
New Workspace - Use this button to create a new workspace. 

 

 
Open Workspace - Use this button to open an existing 
workspace. 

 

 

Save Workspace - Use this button to save newly-created or 
edited workspaces. 
 

 

2. 

3. 

1. 

4. 
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 Device: 

 
Settings - Use this button to access more detailed AWG4162 
option settings. 

 

 

RUN/STOP - This button first loads setting parameters and the 
waveforms into the instrument, and then it starts/stops the 
waveform generation for all enabled channels selected from the 
Channels Selection button. 

 

 

Force Trigger – Clicking this button makes the instrument 
generate an internal trigger signal and forces an event on the 
selected channels/pods.  
 

 Utility: 

 
Remote/Local Mode - Use this button to open the Remote 
Mode window to let the user control the instrument by remote 
connection. 

 
Self Calibration – Use this button to perform a self-calibration of 
the instrument. 

 

Load Factory – Use this button to reload the factory calibration 
parameters. 

 

Diagnostic – Use this button to perform the instrument internal 
diagnostic. 

 Help: 

 
License – Use this button to manage the option (see Option 
Installing part). 

 

Online Help – Use this button to open the online help. 

 

About - Use this button to open the “About” window and 
retrieve information such as the software, dll and firmware 
version. 

 

 

2. Sequence Area - This section mainly provides information on the output sequence. 
3. Waveform List / Quick Settings / Status Area – This section gives access to the Waveform 

List, Quick Settings tools, and the instrument Status. 
 WAVEFORM LIST  Waveforms TAB. This tab contains the list of the arbitrary 

waveforms that the user added to the project. 
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Figure 30 Waveform list 

  
The Waveforms TAB has a toolbar on the aside allowing you to Add, Delete or Copy 
the waveforms. 

Icon Action Arbitrary Mode  

 

New Mixed Waveform  Use this button to add a Mixed waveform to the 
list.  
The waveform editor opens and there you 
can define at the same time the output 
waveforms for all the analog and digital  
available resources. 

 

Edit Waveform Use this button to edit an existed 
waveform. 

 

New Analog Waveform  Use this button to add and edit an analog 
waveform to the list.  

 

 

New Digital Waveform  Use this button to add and edit the stimulus 
for the digital outputs. 
Note: the digital waveform length must be ½ 
or ¼ of the analog waveform length in the 
same sequencer entry. 

 
Copy To Predefined  Use this button to copy the selected 

waveform to the Predefined list. 

 

Delete Waveform  Use this button to delete an existing 
waveform. 

   

 
QUICK TIPS: 

Double click on an existing waveform to open the Editing Waveform 
Window. 
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 WAVEFORM LIST  Subsequences TAB  
It is possible to create a subset of waveforms identifying a Subsequence that can 
be placed into a Sequencer entry by dragging & dropping. 
This TAB contains the list of the available subsequences and the toolbar on the 
right allows you to Add/Edit them. 

 

Figure 31 Sequence list 

 

Icon Action   

 

New Subsequence  Use this button to create a 
Subsequence: the new 
subsequence opens in the 
Sequence Area and you can add 
waveforms to it simply by drag & 
drop them from the Waveform 
TAB. 
Click on the Main Sequence 
button to exit from Subsequence 
edit mode; the created 
subsequence will appear on the 
Subsequences list.    
 
 

 

Edit Subsequence  Use this button to edit an existing 
subsequence. 
Select the Sequence entry from 
the list and press the button to 
edit it in the Sequence Area. 

 
 

 WAVEFORM LIST  Predefined TAB 
This TAB contains the predefined waveforms: predefined waveforms cannot be 
edited, but once they have been copied to the user waveform list they can be 
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opened and edited. 
Predefined waveforms are available on the user workspace with the same 
configuration. 

If you create a Mixed Predefined waveform in Single sequencer DO16 digital bits, it 
will be available on all the workspace with the same features, but it will not be 
available in Multi Sequencer workspace or Single Sequencer DO32 digital bits ones. 
Predefined Analog waveforms will be available in all the user workspace, while 
predefined Digital waveforms will be available in the user workspace that will match 
the same digital configuration (DO16 or DO32).  
You can add a Predefined waveform to the Sequence Area by dragging & dropping. 

 

   
Figure 32 Predefined waveform list 
 

Icon Action   

 

Copy to  Project Waveform Use this button to copy a Predefined waveform 
to the user waveform list: the copied waveform 
can be opened and edited.  
 

 

Delete Predefined 
Waveform  

Remove and delete a predefined waveform from 
the list. 
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 QUICK SETTINGS 
This TAB gives the user quick access to the most useful instrument settings like 
Sampling Rate, Output type and Analog Out Control.  

 
Figure 33 Quick settings 
 

  



  

46 
 

 DEVICE STATUS 
This area of the screen displays channel functionality information as follows. 

 Type - Shows the channel functionality  
 

 

        Figure 34 Device status 
 

4. Waveform Display Area  -This area displays the waveform that you selected in the 
Waveform Table List  or  in the Sequence Area. 
 

NOTE:  

All of the panels in the interface are dockable. You can move individual panels by clicking the panel's top side, 
holding, and dragging with your mouse. 

 

 

Settings  
Use Settings to control the channel settings of the instrument. Access Settings by double clicking on 

the  button in the main toolbar. 

The Settings screen is divided into the following tabs: 

1. The Analog Ch AO1/AO2 Tab   
2. Digital Channels Tab  
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3. The Timing Tab  
4. The Run Mode Tab   
5. The Events Tab  
6. The Dynamic Jump Tab 

 
Setting panel is displayed differently by projects: 

 In Single Sequencer workspace, one Settings panel is available to manage all the channels 

capabilities. 

 In Multi Sequencer workspace, one Settings panel per analog channel is available to manage 

the single channel capabilities: those control panels are called the Master Settings and the 

Slave Settings panels. 

Settings - The Run Mode Tab 

The Run Mode tab is shown by default when the Settings screen is opened. 

Use the Run Mode tab to define the generation mode for the edited sequence. 

 

Figure 35 Run mode tab 

The AWG4162 instrument supports the following four run modes: 

 Sequence – Multiple waveforms can be output in the order specified in the Sequence 

Window. 

 Continuous – A continuous waveform is output. Only one entry is allowed in the Sequence 

Window. 

 Triggered – A waveform is output once when the instrument receives a trigger signal. The 

instrument will wait for the next trigger signal after outputting the waveform. Only one 
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entry is allowed in the Sequence Window. 

The Event 0  is the trigger signal and it can be set in the Events Tab.  

 Gated – The waveform is generated when Event 0 occurs (by default Event 0 = Force Trigger 

button is pressed) and stopped when Event 1 occurs (by default Event 1 = Force Trigger 

button is released). Only one entry is allowed in the Sequence Window. 

The Event 0 and Event 1  are the gate signals (Start/Stop) and they can be set in the Events 

Tab. 

 

NOTE:  

In Sequence and Triggered mode the instrument waits for an event before a waveform is output. It is possible to 
select the output value for the waiting state between the last sample of the current waveform or the first sample 
of the next waveform. 

 

Settings - The Analog Ch Tab (ARB Mode)  

You can use the Analog Ch AO1/AO2 tab to quickly set the parameters of analog channels. 

 

 

Figure 36 Analog Channel Tab 

 Enabled:  To enable a channel output, click the Enabled button.  

 Output  Type:  select the output type (DC Direct, DC Amplified or AC) of the selected 

channel. 
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 Analog Output Controls: you can set parameters for the amplitude scale in %, offset and 

Vocm.  Press the Apply button to confirm the changes. 

 Amplitude Scale(%): the amplitude scale is a real-time parameter that can adjust 

the waveform amplitude while the instrument is running and it is applied to all the 

waveforms contained in the sequencer. 

The default value is 100% and it means that the sequencer waveforms will not be 

scaled, the maximum value is 200% and it means that the waveform amplitude is 

multiplied by two and power multiplied by four. The minimum value is 0% and it 

means that the waveform amplitude is zero. 

NOTE:  

Limitations of output amplitude range apply here. 

 

 Offset: this parameter applies a differential offset to the selected output. It is not 

available on AC output. 

 Vocm(V): this parameter applies a common mode voltage on positive and negative 

outputs of the selected channel. It is not available on AC output. 

 

 Output Parameters: 

 Deskew (ps): this parameter can set a fine delay between the analog to analog 

output channels in order to realign the outputs with a resolution of about 10 ps at 

2.5 GS/s. 

 

 Manual Attenuator: this sets the attenuation type to manual on the DC AMP 

output. By default the attenuation type is automatic. If you check the checkbox 

before “Manual Attenuator”, Manual attenuator is enabled. 

Different rules should be considered for automatic attenuation and manual 

attenuation. 

 Using automatic attenuation, the output will not be attenuated and it helps 

improve the output signal quality for low level signals. 

Using Manual attenuation, the output will be attenuated according to customer’s 

setting. 

The attenuation has effect on DC Amplified output values and on the offset level. It 

does not have an effect on Vocm value. 

 

 Attenuation [dB]:  if you selected the DC Amplified output, you can apply a 

programmable attenuation.  
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 Marker Selection : 

       Marker Selection checkbox   :  When Marker output  is enabled,  the signal comes out from 

the front panel SMA and its maximum update rate is 156.25 MHz at 2.5G S/s. 

                When Marker output is enabled, the following parameters can be set: 

 Marker Output Level:  Set the Marker Out Output level (V)  . 

 Marker Selection: The drop-down list contains Marker / Low / High: it means that you 

can associate to the Marker Out connector the marker digital signal you can edit in the 

Waveform Editor Window or an always low/high level signal. 

 Deskew(ps): this parameter can set a fine delay between the Marker and analog output 

channel in order to realign the outputs with a resolution of about 78 ps at 2.5GS/s. 

 The skew between  analog/digital /Marker depends on the sampling frequency. 

The software automatically calculates the maximum value in relationship to the 

sampling rate you set in the Timing Tab. 

NOTE:  

The “Analog CH” deskew of CH1 also have impact on CH1 digital channels, so with Analog deskew parameter, 
you can shift the entire CH1 outputs (Analog+Digital) in relationship to the CH2. 

 

If you move the Digital skew (Digital channels Tab) of CH1, you can shift the digital 

channels in relationship to the Analog Waveform of CH1, so in this way the digital will be 

shifted from the analog. 

 

Settings - Digital Channels Tab 

Use the Digital Channels tab to set a fine deskew on the digital lines, assign values to the output 

pins and grouping digital lines. 

You can generate a digital pattern to test digital devices such as serial and parallel DACs or to 

emulate protocols. Two Infiniband 12x connectors provide 16 bit LVDS digital outputs each for a 

total of 32 LVDS outputs. 
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Figure 37 Digital channel tab 

 Enabled: to enable the digital output channels, click the Enabled button.  

 Deskew(ps) : this parameter can set a fine delay between the digital channels in order to 
realign the analog and digital outputs with a resolution of about 78 ps at 2.5G S/s. 
The skew between analog/digital channels depends on the sampling frequency.  

 Group Digital Signals: You can change the name of the signals and create / rename buses 

pressing the  button, the following figure is displayed. 
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Figure 38 Digital Logical Name and Grouping window 

 

 The first column displays the digital channels logical names that can be assigned by 
the user. 

 The second column displays the digital pod channel that it is associated to the digital 
logical name.  
“Connected” means that the Digital Probe is connected to the digital channel. 

 The third column displays the device name associated to the digital channel. 
 Left Click + SHIFT to select multiple DO single digital lines, then press the Group 

Selected button to make a bus. 
 Double Click on single signal or bus name to rename it. 
 Select a bus and press the Extend Group Name button to extend the root name to 

the single lines of the bus. 
 Select a bus and press the Ungroup Selected button to ungroup a bus into single 

lines. 
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Settings - Timing Tab 

 

 

Figure 39 Timing tab 

 Sampling Rate: the sample rate can be set to from 100 S/s to 2.5 GS/s for Arbitrary 
mode channels 

 Sampling Clock Source: it may be set to Internal or External. 
If Internal is selected, the sampling clock signal is generated internally. 
If External is selected, the clock signal from the EXT. CLOCK IN SMA connector is used. 
When the External Clock is selected, an External Clock Frequency must be set for your 
clock signal (1.25 GHz to 2.5 GHz). 

NOTE:  

 In the Single Sequencer project, the AO1 is the Master channel and it propagates the sampling clock to 
the slave channel AO2, so the EXT. CLOCK IN CH1 is the only one input available as External clock. 

 In a Multi Sequencer project, both EXT. CLOCK IN SMA inputs are available as External clock, 
because the two channels works independently, or ch2 clock can be set to “Lock to Master Clock” so 
both channels shares the same sampling clock. 

 

 Reference Clock Source: you can select the Reference Source (Internal or External), 
the Reference Source is selectable only when the Sampling Clock Source is set to 
Internal. 
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Settings - Events Tab (Single Sequencer) 

 

The AWG4162 has Event Jump and Wait Event (Input Waveform Properties window) functions which 

change the generation sequence using an event signal. 

Additionally, Triggered and Gated run mode execution depends on Event 0 and Event 1. 

Use the Events tab to set the Events, Trigger IN and Timer parameters.  

 

Figure 40 Events tab 
 

 Event: you can configure up to seven events (Event 0…Event 6) and each event is a logic 

combination between four operands (Operand 1..Operand 4)  and three operators(Operator 

1..Operator 3). 

The Event table contains the event columns and the description columns that give a 

summary of the event setting. 
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Double click on an Event table row to open the Event Editor; the editor gives you access to the 

available operands and operators. 

 

 

Figure 41 Events editor 
 

The logic combination evaluation formula is:  

EventN= (Operand1 Operator1 Operand2)Operator2 Operand3)Operator3 Operand4) 

The possible operations include AND, OR, XOR, NAND, NOR, and XNOR and the possible 

operands include False, True, Trigger IN, Timer, Force Trigger, Not Trigger IN, Not Timer, 

Not Force Trigger, A(0)/Marker1, B(0)/Marker2. 

The Event Manager detects the level of the Operand and it executes the selected logic 

operation. 

The Sequencer will trigger on the edge of the resulting equation. 

 The parameters of the Events tab are explained in the following: 

 Trigger IN:  the event is received by the dedicated SMA Connector on the 

instrument front panel. 

 Timer: the event is a pulse generated by a time counter you can set in the Event 

Tab. If you select “Not Timer” the pulse will be inverted. 

 Force Trigger:  the event is generated by a software trigger pressing the  button 

in the main toolbar. 

 A(0)/Marker1, B(0)/Marker2:  the marker event can only be used for jump in 

sequence and stop event in gate. In other case, marker event can't take effect. 

B(0)/Marker2 is available in Multi-Sequencer workspace only. 

 NOT: the “Not” gives the user the possibility to invert the signal polarity. For 

example “Not Trigger In” event takes effect on the falling edge of the Trigger In 

signal. 

 Trigger IN - Threshold(V):  use this field to select the Trigger IN threshold voltage 

level.  

 Timer Period - Value (uS):  use this field to set the value of the time counter in us. 
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Settings - Events Tab (Multi Sequencer) 

In Multi Sequencer workspace, the Event TAB parameters are the same of the Single Sequencer 

workspace except for Using Master Event led placed on the Slave Settings panel.  

 

Figure 42 Events tab (Multi sequencer) 
If you enable the Use Master Events control, the Slave event list will be disabled and the Slave 

channel will use the events of the master channel to control the generation sequence. 
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Settings - Dynamic Jump 

Use this tab to modify the execution flow of the sequencer by forcing a specific entry to be 

executed.  

 

Figure 43 Dynamic jump tab 

Take the following procedures to modify the sequencer: 

1. Specify the relationship between the Set Jump Address value and the entry of the sequencer 

in the Dynamic Jump table. 

2. Use the “Set Jump address” field to select one of the available entries in the JumpBit 

column. 

3. Press the Apply button. 

4. The Enabled button enable/disable the dynamic jumps. 

5. If change the value in table “Dynamic Jump”, it won’t take effect until press ok to close 

setting; Then reopen setting to operate "Set Jump Address" 
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Waveform Window 
You can use the Editing Waveform Window menu to create a new analog/digital waveform or 

modify an existing waveform. 

The AWG4162 instrument has two analog outputs and up to 32 digital channels that the user can 

configure according at his needs. 

Take the following steps to create a new waveform or edit a waveform: 

1. Use the Waveforms TAB toolbar buttons to create a New Mixed  / Analog   / Digital 

Waveform .  

PLEASE NOTE THE FOLLOWING: 

 The Mixed Waveform is the easiest way to create a new entry for the Sequencer 

because it inserts in the same entry both analog and digital channels correctly 

formatted.  

 If you want to modify an existing waveform you can double click it on the Waveforms 

TAB to open the Editing Waveform window. 

 

2. The New Waveform window is displayed as shown in the following figure. Type the name of 
the waveform and choose the samples length. You can insert the Length in Samples or Time. 
Click OK to confirm. 

 
Figure 44 New waveform dialogue box 

Note: Waveform length must be multiple of 64(<320 points) or 16 (>=320 points).  
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3. The Editing Waveform Window is displayed as shown in the following.  
 

 

Figure 45 Editing waveform window 

Numbered callouts on this image correspond with the following interface section 
descriptions. 
 

1. Analog/Digital Waveform Graph Tools 
2. Mixed Signal Waveform Editor 
3. Data Editor 

 

  

3. 

1. 

2. 
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Cursors Tools 

Cursors/Tools TAB gives you access to the following functions: 
 

Cursors  

Cursors are useful to identify and enlighten waveform data for improved organization and viewing.  

Clicking the Cursors  button on the Editing Waveform main toolset shows or hides the 

marker window. 

 

Figure 46 Tool menu 

 

Other field values on the toolbar show the Active (or ID) of the currently selected cursor, and its 

Absolute and Relative positions. 

When Cursors are turned on, all of the cursors present in the Waveform Editing Window are listed 

inside the Cursor screen. 

 
Figure 47 Cursor list 

The Master Cursor is the one labeled with the following icon. 

 

Relative positions are calculated from the master cursor position. 
The master cursor automatically moved during a data search operation to show relative 
results. 
Change the master cursor by selecting the new marker in the cursor window and clicking the 
Master Cursor icon in the Waveform Editing Window toolbar. 

 
Cursor screen columns show the progressive cursor identifiers, the absolute time position (the 
time distance between the cursor position and the start of the acquisition) and the relative 
time position (the time distance between the cursor and the master cursor). Any time one of 

Cursor ID, Active and Relative Position Show or Hide 

Cursors 
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the cursor is moved, all the values are automatically updated and shown. 

The following functions are used on Cursor. 
 

 
The Add button puts a new cursor in the visualization area. 

 
The Remove button eliminates the marker selected in the 
Cursor screen. 

 

Move a marker by clicking and dragging a selected cursor. 

 
Remove all cursor by clicking the Clear all cursor button. 

NOTE:  

 You can also perform many of the aforementioned functions by right clicking inside the Cursor screen 
and choosing from the list of functions shown. 

  You can remove all cursors except for one. 

 You can create as many cursors as needed. 

 

Go To a Selected Target 

The Go to field on the Editing Waveform main toolset contains multiple functions on its right side 

drop-down. The functions allow you to select the position where the master marker is going to be 

moved within the visualization area. 

The Go to functions include: 

 
Go to time - Moves the master cursor to the time position 
specified in the text field to the left of the control. 

 
Go to start samples - Moves the master cursor and 
visualization area to the start of the acquisition. 

 
Go to end samples - Moves the master cursor and 
visualization area to the end of the acquisition. 

 
Cursor n - Centers the visualization area on the 
cursor/marker n (position specified in the text field to the 
left of the control). 

 

 
You can move the selected cursor to the middle of the 
current visualization by clicking the Move active cursor 
here button. 
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Search 

Searching can be done from the Editing Waveform Window. It is also available in the 

aforementioned search section regarding the Waveform View screen. 

You can search for a specific bus, signal, rising, or falling edge value. 

Activate the search option by clicking the Search Settings button . 

The Search Settings window is shown as follows. You can input search criteria here. 

 

Figure 48 Search settings window 

In the Signal Type search list on the right side of the Search Settings window, all defined 

analog/digital signals and busses are shown. Select the signal or bus and then provide a specific 

value for the search. 

NOTE:  

The Compare and Value fields change depending on the Signal Type selected in the search list. 

 

Use the Compare field to select between the following Search logic operators: 

   = or Is - Find the equivalent value. 

   != or Is not - Find the unequal value. 

   > - Find values greater than the one specified (on digital channels only available if a bus is 

selected). 
   < - Find values less than the one specified (on digital channels only available if a bus is 
selected). 

On digital channels use the Value field to provide the specific value or edge on which to search. If 
one channel is selected, the Value field has the following options: 

 0 - Searches for a logic 0. 

 1 - Searches for a logic 1. 

 Rise - Searches for a Rising Edge trigger.  

 Fall - Searches for a Falling Edge trigger.  

 Change - Searches for any trigger edge.  

 HiZ 
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 Violations – Searches for any timing violations on Analog Marker. The Analog Marker 
maximum update rate is 156.25 MHz; in case of timing violations, a warning symbol appears 
next to the digital waveform label. 
 

  
Figure 49 Search result window 1 
 

  
 
Figure 50 Search result window 2 
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To cancel the timing violations, the following procedure should be applied: 
1. Open the Search window and select the digital waveform where the violations 

occur. 
2. Select Violations and press OK. 
3. Press the Next button to move the cursor on the timing violation. 
4. Remove the timing violation manually filling the values with ‘0’s or ‘1’s. 
5. Remove all the timing violations on the Marker waveform. 
6. Please note that it is possible to start the waveform generation even if all the 

violations are not solved, but the analog marker will work out of specification. 
 
 

The From Start button can be used to specify where the search starts within your data generation. 

Possible options include: 

 From Start - Starts the search from the beginning of the waveform. 

 From End - Starts the search from the end of the waveform. 

 Master Marker - Starts the search from the Master Marker position. 

You can select criteria on the Search Settings screen and click the OK button. The results are then 

shown on the Editing Waveform Window. 

You can use the Search Backward or Search Forward buttons to navigate through your search 

results. 

NOTE:  

As you navigate through your search results, the master cursor is updated to the subsequent values in your 
results. 

 

Graph Tools 

 

Cursors/Tools TAB: This button allows changes the mouse 
function for the graphic area to cursors/markers movement. 

 
Cursors/Tools TAB: The hand tool allows you to dragging inside 
the graph area. 

 

 
Cursors/Tools TAB: You can change the properties of the graph 
display area. Click the Waveform View Settings button and the 
Graph Property screen is shown. 
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Changes can be made as follows: 

   The Background Color can be changed as desired. 

   Change colors and turn the Major and Minor Grids on or off 
and change their line coloring. 

   Cursor Position indicators can be turned on or off. 
 

 
This button switches the X-axis representation between number 
of samples to seconds. Default values are optimized based on 
the selection made. 
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Zoom Tools 

Zoom TAB gives you access to the following zoom functions: 
 

 

Zoom In: Auto zoom in function. 

 
Zoom Out: Auto zoom out function. 

 

Zoom Manual: This button allows zooming in on a selected 

rectangle of the graph. Click and drag inside the graph area 
to create your zoom rectangle. 

 

Zoom All: This button resets all activated zooms 

 

Cursors: This button allows changes the mouse function for the 
graphic area to cursors/markers movement. 

 

 

Analog Waveform Graph Tools 

AWG4162 instrument handles Analog Waveforms, Segments, and Components as explained in the 

next parts. 

Analog Waveform 

An analog waveform is a sequence of elementary segments and it contains the temporal order by 

which the segments are generated. 

You can add a standard waveform simply by pressing the Edit button and choosing a basic waveform 

like DC Level, Sine, Increase Ramp, Triangle, Sawtooth, Rectangle etc. The AWG4162 software will 

display a waveform made of one segment. 
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If you need to generate more advanced waveforms, you should add more segments to your 

waveform. 

 

Figure 51 Analog waveform 

Segment 

A Segment contains one or more Components, all of the same length, combined by means of the 

elementary Add, Subtract, Multiply operations. 

If one Segment contains more Components, the following formula will be applied: 

 

Segment = (Component1 (Add/Sub/Multiply)Component2) Add Component 3 Add Component 4 

Add Component N 

 

  

Waveform 

Component 

Segment 
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Component 

A Component is the basic element for the construction of a Segment. Each Component may be 

represented by a standard waveform (DC Level, Sine, Cosine, Exponential, Triangle, Rectangle, Ramp, 

Pulse, Sync, Sawtooth, Sweep), by a Formula, or its component samples can be loaded from a text 

file. 

In any case, the samples of a Component are calculated/loaded as a function of the AWG4162 

frequency (sample rate) and of the length of the component itself (number of points). 

 

 

 

This button allows changes the waveform length. Click on the 
Samples/Time button to change the waveform length 
visualization from samplers to time. 
PLEASE NOTE THE FOLLOWING: 

 In Arbitrary Mode the allowed waveform length is 64 
to 64M samples in multiple of 64 for < 320 samples or 
in multiple of 16 for >= 320 samples. 

 All segments and components will be re sampled. 

 
Vertical Zoom Auto scale function for the selected analog 
waveform.  

 

 

Vertical Zoom Auto zoom in function for the selected analog 
waveform. 

 
Vertical Zoom Auto zoom out function for the selected analog 
waveform. 

 

Press the Edit button to open the Waveform 
Standard Editor Window and create a basic 
waveform like DC Level, Sine, Increase Ramp, 
Triangle, Sawtooth, or Rectangle. 
Click the arrow to open the pop-up menu: select the 
standard waveform (Sine, Triangle, Square,etc.) as 
short-cut for the Waveform Standard Editor Window. 

 

Press the Remove button to remove the selected Segment / 
Component of the waveform. This button is active only if more 
than one segment/component exists in the current waveform. 

 Right-click on the Waveform/Segment/Component to open the 
context menu. Select Properties to open the waveform/segment 
properties window and change the waveform display parameters 
like color, plot height or resize the segment length. 

http://www.tektronix.com/


www.Tektronix.com   

69 
 

 
 

 

Press the Effect button to open the Effects Settings and 
Parameters window and add noise, filtering to your analog 
waveforms.  

 

Waveform Standard Editor Window 

Press the Edit button and the Waveform Standard Editor Window is shown. 

This window shown as follows allows you to edit standard waveforms, segments and components 

parameters. 

 

Figure 52 Waveform standard editor window 
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The Type menu allows selecting the waveform among a list of possible signals or functions. 

Depending on the selected Type, different parameter may be edited. The different possibilities 

include the following:  

Type Available Parameters 

 

DC Level 

 

Offset [V] 

 

Sine 

 

Frequency[Hz/cycles], Amplitude[V], Phase[°], 

Offset[V],Cycles 

 

Cosine 

 

Frequency[Hz/cycles], Amplitude[V], Phase[°], Offset[V], 

Cycles 

 

Triangle 

 

Frequency[Hz/cycles], Amplitude[V], Phase[°], 

Offset[V],Cycles 

 

Rectangle 

 

Frequency[Hz/cycles], Amplitude[V], Phase[°], Offset[V], 

Duty Cycle [%],Rise time[s], Fall time[s], Cycles 

 

Saw tooth 

 

Frequency[Hz/cycles], Amplitude[V], Phase[°], Offset[V], 

Cycles 

 

Increase Ramp 

 

Amplitude[V], Offset[V] 

 

Decrease Ramp 

 

Amplitude[V], Offset[V] 

 

Pulse 

 

Amplitude[V], Delay[s], Width[s], Offset[V] 

 

Sinc 

 

Amplitude[V], Offset[V], Peak Position[s], Lobe Width[s], 
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Exponential 

 

Frequency[Hz/cycles], Vo[V], Vinf[V], Time Constant[s] 

 

Sweep 

 

Amplitude[V], Offset[V], Start Frequency[Hz], Stop 

Frequency[Hz] 

 

Formula 

Calculator Window 

 

 

From File 

Explorer Window 

 

Custom Insert the sample values by editing the table entries 
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PRBS (PRBS pattern) Amplitude[V], Offset[V],Equation, Invert 

 

The Formula type allows defining the waveform by means of a mathematical expression. 

The waveform is edited by using the Formula Editor window that can be activated by clicking the Edit 

Formula button. The mathematical expression can be a function of time or a function of samples by 

using the t or x variables, respectively. The software verifies, in run time, that the component to be 

edited does not exceed the limits for the selected output and that the formula syntax is correct. In 

case of error, an error indication is shown in the Error message indicator. 

 

 

Figure 53 New waveform 
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Effect Settings and Parameters Window (Analog Waveforms Only) 

 

Press the Effect  button and the Effects Settings and Parameters Window is shown. 

On the Settings Tab for each waveform you can select to add a noise effect, a filter, noise 

then filter (noise and filter), filter then noise (filter and noise) . 

 

  

 Figure 54 Effect settings and parameters 
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Filter Settings TAB 

This tab allows you to apply a digital filter to the selected waveform. 

 

 

Figure 55 Filtering waveform 

Formula waveform view 

When creating standard analog and digital waveforms, sine and square wave (rectangular) types are 

commonly used (alone or in combination with other waveshapes). 

However, when waveform creation cannot be accomplished using simple combinations of standard 

waveform types, importing waveforms from a measurement instrument, file, or creating it 

analytically using equations or formulae are ideal methods. 
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Create waveform with Formulas 

This section of the manual shows you how to create various waveforms using formulas in AWG4162. 

It covers the standard steps used to create an advanced waveform component using formulas. 

Remaining topics show example formulas producing various waveform types. 

Similar to most other tasks in AWG4162, you must first create a workspace with Arbitrary Waveform 

Generator as the Operating Mode. 

If you already have a workspace open, be sure it meets the aforementioned requirements before 

proceeding with the following steps: 

1. Click the New Mixed Waveform button.  

The New Waveform window is shown. Type the name of the waveform “Wave1” and 

choose 10000 for the samples length of the waveform. Click OK to confirm. 

 
Figure 56  New waveform 

  

http://www.tektronix.com/


www.Tektronix.com   

76 
 

3. The Editing Waveform Window is shown. Select the waveform Wave1 and click on the Edit  

 button. 

 

Figure 57  Digital waveform editor 
4. On the Type drop-down list select Formula. The Formula Editor is then shown on the right. 

The editor helps building your waveform analytically using equations. Your equation can be 

based on time(t) or samples(x). 

Please pay attention to the following: 

 Your formula is shown in the text box as it’s built. 

 Numeric values can be entered from the keypad along with n (nano), µ (micro), m (milli), 

K (kilo),M (Mega), and G (Giga) multipliers. 

 Equations can be based on the functions Sin, Cosine, Log base 2, Log Base 10, Pow (rise 

to a power), Square Root, Sign, Tan, Ln (Natural Log), Abs, Exp, Integer, ArcSine, Arc 

Cosine, Arc Tan, Ceiling, and Floor along with the basic arithmetic operators + 

(addition), - (subtraction), * (multiplication), and / (division). 

 The Preview button compiles your formula and renders it on the graph above the 

Component Definition dialog. 

 The OK button saves your formula and exits from the Waveform Standard Editor 

window. 
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At this point, your newly-created waveform (made using formulas) is now saved as a waveform. 

You can create additional components and/or add your newly-created component to the sequencer 

and output your waveform from AWG4162. 

Exponentially Decaying Sine Wave 

An exponentially decaying 2 MHz sine wave is shown in the following figure. The actual formula 

used here is Exp(-t/E-6)*Sin(2*3.14592*2*E6*t). 

 
Figure 58 Exponentially decaying sine wave 
 

Formula's General Format  

V*Exp(-t/Tc)*Sin(2*pi*t*Fs) 

Where 

 Tc – Time Constant in seconds 

 Fs - Sine wave frequency in Hertz 

 V – Signal amplitude in Volts peak 
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Ramp 

A ramp waveform is shown in the following figure. The actual formula used here is 0.2*E6*t. 

 
 

Figure 59 Ramp waveform 

 
Formula's General Format 

A*t 

Where A – Slope of the ramp in Volts/second. 
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Rising Exponential 

A rising exponential waveform. The actual formula used here is 1-Exp(-t/(1*E-6)). 

 
 

Figure 60 Rising exponential waveform 

 

Formula's General Format 

1-Exp(-t/Tc) 

Where Tc – Time Constant in seconds. 
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Decaying Exponential 

A decaying exponential waveform is shown as follows. The actual formula used here is Exp(-t/(1*E-

6)). 

 
 

Figure 61 Decaying exponential waveform 

 
Formula's General Format 

Exp(-t/Tc) 

Where Tc – Time Constant in seconds. 
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Sine 

 A linear amplitude sweep of a 1 MHz sine waveform is shown as follows. The actual formula used 

here is Sin(2*3.141592*2*E6*t). 

 

Figure 62 Sine waveform 

Formula's General Format 

V*Sin(2*pi*t*Fs) 
Where 

   Fs – Sine Wave frequency in Hertz. 

   V – Signal amplitude in Volts peak. 
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Linear Amplitude Sweep of a Sine Wave 

A Sine waveform is shown as follows. The actual formula used here is 
0.2*E6*t*Sin(4*3.141592*E6*t). 

Figure 63 Sine waveform 

 
Formula's General Format 

(A*t) *Sin(2*pi*t* Fs)  
Where 

   Fs – Sine Wave frequency in Hertz. 

   A – Slope of the ramp in Volts/second. 
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Frequency Modulation 

A frequency modulation waveform is shown in the following figure. The actual formula used here is 

Sin(2*3.141592*2*E6*t+2*Cos(2*3.141592*0.4*E6*t)). 

 
Figure 64 Frequency modulation waveform 

Formula's General Format 

V*Sin (2*pi*t*Fc+(FD/FM)*Cos(2*pi*t*FM)) 

Where 

   Fc – Carrier frequency in Hertz. 

   FD – Frequency deviation in Hertz. 

   FM – Modulation frequency in Hertz. 

   V – Signal amplitude in Volts peak. 
 

  

http://www.tektronix.com/


www.Tektronix.com   

84 
 

Phase Modulation 

A phase modulation waveform is shown as follows. The actual formula used here is 

Sin(2*3.141592*2*2*E6*t+(3.141592*Sin(2*3.141592*0.4*E6*t))). 

 

Figure 65 Phase modulation waveform  
 

Formula's General Format  

V*Sin((2*pi*t*Fc+ K*Sin(2*pi*t*FM))  

Where 

Fc – Carrier frequency in Hertz. 

K – Peak phase excursion in radians. 

FM – Modulation frequency in Hertz. 

V – Signal amplitude in Volts peak. 
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Lin A linear frequency sweep waveform 

Linear Frequency Sweep waveform is shown as follows. The actual formula used here is 

Sin(3.141592*(2*t*E6+((8*E6 -1*E6)/(10*E-6))*Pow(t,2))).  

 

Figure 66 Linear frequency sweep waveform 

 

Formula's General Format  

V*Sin(pi*(2*t*Fs+((FE-Fs)/Ts)*T^2))  

 

Where 

 Fs – Start frequency in Hertz. 

 FE – End frequency in Hertz. 

 Ts – Sweep duration in seconds. 

 V – Signal amplitude in Volts peak. 
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Gaussian Pulse 

A Gaussian pulse waveform is shown as follows. The actual formula used here is Exp(-(8)*Pow(((t-

2*E-6)/(E-6)),2). 

 
 
Figure 67 Gaussian pulse waveform 

Formula's General Format 

V*Exp(-(1/2)*((T-TM)/Tσ)^2 

Where 

   TM – Time location of the mean of the Gaussian pulse. 

   Tσ – Half width point of Gaussian pulse corresponds to the standard deviation σ. 

   V – Signal amplitude in Volts peak. 
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Amplitude Modulated Sine 

An amplitude modulated sine waveform is shown as follows. The actual formula used here is 
0.5*Sin(2*3.141592*2*E6*t)*(1+0.75*Cos(2*3.141592*0.2*E6*t)). 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 68 Amplitude modulated sine waveform 

Formula's General Format 

V*Sin(2*pi*t* Fs) *(1+K*Cos(2*pi*t*FM)) 

Where 

   Fs – Sine wave frequency in Hertz. 

   FM – Modulation frequency in Hertz. 

   K – Modulation index, 0<K<1. 

   V – Signal amplitude in Volts peak. 
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Full-Wave Rectified Sine 

A full-wave rectified sine waveform is shown as follows. The actual formula used here is 

Abs(Sin(2*3.141592*E6*t)). 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 69 Full-wave rectified sine waveform 

Formula's General Format 

V*Abs(Sin(2*3.141592*Fs*t)) 

Where  

  Fs – Sine wave frequency in Hertz. 

  V – Signal amplitude in Volts peak. 

 

  

http://www.tektronix.com/


www.Tektronix.com   

89 
 

 

Filter 

 This section allows you to select whether the digital filtering is to be applied to the entire 
waveform or to a limited part.  
If you click on the waveform name in the Analog Waveform Graph Viewer/Editor, the 
selection range indicators will display the entire waveform limits. 
If you need to apply the filter to a limited part, click and drag inside the graph area to create 

a rectangle delimiting the waveform section to be filtered. Their position is shown in the 

same Application Zone section. 

FILTER Specifications 

This section allows setting all the characteristics of the filter. 

 Digital Mode IIR (Infinite Impulse Filter) - Bessel, Butterworth, Chebyshev, Inverse 

Chebyshev, and Elliptic. 

 Digital Mode FIR (Finite Impulse Filter) - EquiRipple, Kaiser, and Windowed. 

 Type - Low Pass, High Pass, Band Pass, Band Stop, and General. 

 Initial Condition – Steady State Response means the output is in steady-state, since 

the input has fully engaged the filter. 

Type, Topology and filter Order options depend on the specific filter characteristics. 

Click OK button and the set filtering options are applied to the waveform. A preview of the 

filter/noise effects on the waveform is shown in the graph area.  

You can remove a filter by clicking the current waveform and selecting the None option on 

the Setting tab. 
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Noise Settings Tab 

This tab allows you to apply noise to the selected waveform.  

 

Figure 70  Noise setting tab 

The Noise setting tab is divided into Application Zone, Noise Specification, and Parameters 

sections. 

NOISE Application Zone 

This section allows selecting whether noise is to be applied to the entire waveform or to 
a limited part of it. 
If you click on the waveform name in the Analog Waveform Editor, the selection range 
indicators will display the entire waveform limits. 
If you need to apply the noise to a limited part, click and drag inside the graph area to create 

a rectangle delimiting the waveform section. Their position is shown in the same Application 

Zone section. 
 

 

Noise Specifications 

This section allows setting all the noise characteristics. 

Noise Type - Use this drop-down to select the noise type applied to the waveform. Options 

include Gaussian, Uniform, and White. 

Depending on the selected noise type, specific parameters (Standard Deviation or 

Amplitude) are enabled together with the Scale Factor field, for increasing/decreasing noise 

intensity. 

Click the OK button and the noise options set are applied to the waveform. A preview of the 
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noise effects on the waveform is shown in the graph area. 

Remove a filter by clicking the current waveform and selecting None on the Settings Tab. 

Import / export 

Import of Analog Waveform 

Data import functions allow you to use waveform data created outside the arbitrary 
waveform generator. You can import data to create a new waveform or to replace 
existing waveform data. 

The arbitrary waveform generator supports the following file formats: 

The supported file formats are:  

 ISF  

 TXT - Tab separated value file 

 CSV – Comma separated value file 

 WFM – Tekscope Series waveform(Depend on scope model) 

 PAT – AWG Series pattern file(Depend on AWG model) 

 TFW – AFG3000 Series waveform file format 

 RFD – RFXpress file format 

 MAT – Matlab .mat file format.   
 

The Matlab file format needs to follow this format:  

 

NumPoints = 2400;       %Waveform length 

t = (0:1:NumPoints-1)';  %Define t vector 

waveform = single(sin(2*pi*1/NumPoints*t)); %Create single sinewave 

%% Save Waveform 

Waveform_Name_1 = 'SINE';       %Name Waveform 

Waveform_Data_1 = waveform;     %Assign waveform data 

Waveform_Sampling_Rate_1 = 2.4e9;    %You can specify sample rate in S/s 

Waveform_Amplitude_1 = 0.300;          %and amplitude in V 

save('SingleCycleSine', '*_1', '-v7.3');    %Save all variables ending in _1 to .mat file 
 
 

How to Import an Analog or Mixed Waveform (TXT Files) 

 Select the Analog Waveform associated to the Channel AO1 or Channel AO2 and 

press the Import  button. 
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The import form is open, as shown in the following figure. 

 
Figure 71  Import waveform 

The following options are available on the Import Waveform form: 

 Sample rate (sample/s): it is sampling rate of the points that will be imported 

 Header lines to remove: the import file could have some header lines that needs to 

be removed before importing it; And you also can remove some points from the 

start of import file. 

 Decimal separator: it can be  or  , 

 Interpolation: if the file sampling rate is different from the instrument sampling 

rate, you can choose the Interpolation method between Linear,Coerce and 

Polinomial. 

 Memory Overflow: if the import file has more points than the current waveform, 

the overflow points will be cut off(“Cut off tail”)  

 Last Points: Return to Zero means that the last points of the waveform will be zero 

in case the imported waveform is shorter than the actual total samples points. 

Otherwise if Last value is selected, it will maintain the last waveform sample. 
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If the selected TXT file has only one 
column, it will be interpreted as an analog 
signals and so only the analog part will be 
imported applying the options above. 
If the selected TXT file has more than one 
column, the following cases can happen: 
TXT Mixed Waveform File with Header 
(#AO1,#0,#1…..,#n) 

The first column contains the analog data, 
while the other columns will be interpreted 
as the digital lines. Please note that the 
digital lines that will be imported depends on 
the number of lines present in the current 
project. 
Example 1: if the header is 
#AO1,#0,#1…..,#15, but the project has 32 
digital lines, only the first 16 digital lines will 
be imported according to the header and the 
other ones will remain as is. 
Example 2: if you try to import a Single 
Sequencer header on a Multi-Sequencer 
project, the analog channel will be imported 
in the selected Multi-Sequencer channel (no 
matter if header is #AO1 or #AO2) and the 
digital channels will be imported on the 
selected Multi-Sequencer digital lines. Please 
note  that in Multi-Sequencer, the digital 
lines will be always marked as #0,….,#15 or 
#0,….,#8, so digital lines with #16,……,#31 
(Single Sequencer) should start from #0. 

.TXT file: 2 columns without header The first column will be imported as analog 
data, the second column will be imported as 
Marker data relative to the selected channel 
(AO1 or AO2) 

TXT file: 3 columns without header The first column will be imported as analog 
data, the second column will be imported as 
Marker data relative to the selected channel 
(AO1 or AO2). The third column will be 
ignored. 

TXT file: more than 3 columns without 
header 

The first column will be imported as Analog 
data, the other columns will be imported as 
digital lines. 
#Analog,#D0,#D1,#D2,#D3,#D4…………. 

 

IMPORT of Digital Waveforms 

Select a digital line and press the Import button. 

 

The Import file format for digital waveforms is a comma separated value file where each 

column represent the samples of one digital channel. 

The first row of the file is a header that represent the number of the digital channel 

(#0,#1,#2……..,#15) associated to the logical name. 

Please not that if digital lines are not matchable in the header line, the digital bit can’t 
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be imported successfully; you need to remove the digital header line numbers to import 

correctly the file. 

The digital data import format is.txt ; the file is comma separated and it can have an header on 
the first line. 
The Import Waveform window will open, please see as below. 
 

 

Figure 72  Import Waveform window 
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Export of Analog, Digital and Mixed Waveforms 

Press the Export   button to open the Export Waveform window: 

 

 

Figure 73  Export waveform  

This window lets you to export the Analog, Digital or Mixed Waveform relative to the 

channel 1 (A01/POD A) or channel 2 (A02/POD B). 

When you select “Analog Waveform”, the Export file format for analog waveforms is a 

comma separated value file (only one column) where the column represent the samples 

of the selected analog channel. 

The first two rows of the exported file is a header that represent the sample rate and 

the number of samples (# Sample rate: 2500000000 # Samples: 2048).  

The exported values representation is double. 

If you select “Digital Waveform”, the Export file format for digital waveforms is a 

comma separated value file where each column represent the samples of one digital 

channel. 

The first row of the file is a header that represent the number of the digital channel 

(#0,#1,#2……..,#15) associated to the logical name. 

Example 1(POD A 16 digital lines): 

#0,#1,#2,#3,#4,#5,#6,#7,#8,#9,#10,#11,#12,#13,#14,#15 
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0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0 

0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0 

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 

0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0 

0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0 

 

Example 2 (POD B 16 digital lines): 

#16,#17,#18,#19,#20,#21,#22,#23,#24,#25,#26,#27,#28,#29,#30,#31 

0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0 

0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0 

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 

.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 

0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0 

0,0,0,0,0,1,0,0,0,0,0,0,0,0,0,0  

 

If you select “Mixed Waveform”, the Export file format for mixed waveforms is a 

comma separated value file where the first column represents the analog data and the 

other columns represent each the samples of one digital channel. 

The first row of the file is a header that represent the analog waveform and number of 

the digital channel associated to the logical name. 

 

SINGLE SEQUENCER HEADER format: 

 AO1/POD A – 8 bit mode - 

#AO1,#0,#1,#2,#3,#4,#5,#6,#7   

 AO1/POD A – 16 bit mode -        

#AO1,#0,#1,#2,#3,#4,#5,#6,#7,#8,#9,#10,#11,#12,#13,#14,#15   

 AO2/POD B – 8 bit mode - 

#AO2,#16,#17,#18,#19,#20,#21,#22,#23   

 AO2/POD B – 16 bit mode -         

#AO2,#16,#17,#18,#19,#20,#21,#22,#23,#24,#25,#26,#27,#28,#29,#30,#31   

 

MULTI SEQUENCER HEADER format: 

 AO1/POD A – 8 bit mode - 
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#AO1,#0,#1,#2,#3,#4,#5,#6,#7   

 AO1/POD A – 16 bit mode -        

#AO1,#0,#1,#2,#3,#4,#5,#6,#7,#8,#9,#10,#11,#12,#13,#14,#15   

 AO2/POD B – 8 bit mode - 

#AO2,#0,#1,#2,#3,#4,#5,#6,#7   

 AO2/POD B – 16 bit mode -         

#AO2,#0,#1,#2,#3,#4,#5,#6,#7,#8,#9,#10,#11,#12,#13,#14,#15   

 

Please note that if you will try to import single sequencer mixed/digital waveforms in multi 

sequencer workspace, some mismatches in digital lines can happens. 

In particular if you will try to import #AO2,#16,……,#31 (Single Sequencer) in Multi Sequencer 

project, you have to cut the header to import also the digital lines, otherwise they will be skipped.  

Please note that the import/export functions can become slow with large amount of data to import 

or export. 

 

Digital Waveform Graph Tools 

This toolbar contains several commands for use on digital waveforms as follows: 

  

 

Signal/bus to 0. 

 

Signal/bus to 1. 

 

Signal/bus to Arbitrary Value. Arbitrary Value allows overwriting 
a node value over the selected waveform, waveform interval, or 
across one or more nodes or groups. 
Overwrite a node value using the following steps: 

1. Select a node or a bus and click the Value button on the 
Digital Editor toolbar. The Arbitrary Value dialog box 
appears. 

 
2.  In the Radix button, select the radix type. 
3. Specify the new value you want overwritten in the 

Numeric or named value box. 
4. Click OK. 
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Clock Editor for selected signal. 
The Clock feature can be used to automatically generate 
the clock wave, rather than drawing each clock triggering 
pulse. 

The start and end time of a clock signal can also be selected. 

 

 

Counter Editor for selected bus. 
The counter editor applies a count value to a bus which 
increments the value of the bus by a specified time 
interval. 

Instead of manually editing the values for each node, 
the Counter editor automatically creates the 
counting values for buses. 

You can also specify a starting value for a bus and the time 
interval for increments. 

 
 

 

Random Value for signal/bus. 
Random Value allows generating random node values over the 
selected waveform, waveform interval, or across one or more 
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nodes or groups. 
Random node values can be generated for each grid interval, a 
specified time, or at fixed intervals. 

 

 
 

 

Invert signal/bus value. 

 
Copy Waveform. 

Select the entire waveform clicking on the signal/bus 

name on the left column or select a portion of it with 

mouse selection. 

Press the Copy Waveform button to copy the waveform. 

 

 

Paste Waveform. 
Paste the copied waveform into a selected area of the 
graph (mouse selection) or from the start of another 
waveform. 

 

 

Mixed Signal Waveform Editor   

The Mixed Signal Waveform Editor screen is used to create or edit analog and digital 

waveforms in a graphic or tabular format. 

 Single signals are visualized as analog or digital signals, while grouped signals are 

represented as buses. 

 

Analog Waveform Editor  

Arbitrary edited waveforms can be generated as they have been set.  

Think of a waveform as a list of Segments, where each segment can contain one or more 
Components, all of the same length, combined by means of the elementary 
Add, Subtract, Multiply operations. 
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Each waveform may be constituted by an arbitrary number of segments and each segment can have 

its own length. 

In Arbitrary mode each waveform must be constituted by a multiple number of samples of 64 for 

<320 samples length or in multiple of 16 for >= 320 samples. 

 

Figure 74 Waveform segments 

The waveform in the picture above is the composition of two segments. Each segment is 

made of one component. 

 

 

 

 

 

 

 

Segment 
Component 

http://www.tektronix.com/


www.Tektronix.com   

101 
 

 

Figure 75  Waveform components 

The waveform in the picture above is made of one segment. The segment is the composition of two 

Components multiplied together: Segment1 = Component1 * Component2.  

 

 

  

Component1

= Sine 
Component 2 = 

Cosine 
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Common operations can be directly performed on waveforms, segments and components 
(Selection, Left Click, Right Click). Drag and Drop operation between analog waveforms is not 
allowed. 
 
LEFT CLICK AND SELECTION 

 Left Click on the analog Signals cell to select the entire waveform that will be 
enlightened in blue.  

 Click and drag inside the graph area to create a rectangle delimiting the waveform 
section. You can add Effects on the selection. 

 Left Click on the Signals cell tree item to open/close the Segments of the 
waveform. 

 Left Click on the Segment tree item to open/close the Components of the single 
segment. 

 Resize the signal amplitude by dragging the line between a signal name cell. 
 To the right of every analog signal, a number indicates the value the signal at the 

time position of the master cursor. 
 
 

RIGHT CLICK 

A Right Click on a Waveform tree item activates a pop-up menu, with functions depending on a 
Waveform or Segment selection as follows. 
 

 

Figure 76  Right-click pop-up menu 

 Vertical Autoscale On – Enable the auto scale function;  
 Autoscale Off – Select this option to disable the waveform auto scale. it will appear a 

vertical scrollbar on the right side of the Signals cell you can use to scroll up and down 
the selected waveform. 

 Vertical Zoom In – Auto zoom in function.  
 Add Segment –  To add a segment you have to increment the waveform length or 

resize/delete the existing segments.  
For example if you have a 10k samples waveform made of one segment and you need to 
add a second segment to it, you can perform the following operations: 

 Right click on the existing segment to activate the pop-up menu and select 
Property. The Segment1 Property window is shown: resize the Segment1 length 
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from 10K to 5K. 

 

Figure 77  Property window 

 Right click on the Waveform or on the existing Segment to activate the pop-up 
menu and select Add Segment. 
 The Segment2 Property window is shown, insert the new segment length and 
press OK to add it to the waveform. 
PLEASE NOTE THE FOLLOWING: 
If you select the Add Segment option from the Segment pop-up menu, the new 
one will be added at the end; if you select the Add Segment option from the 
Waveform pop-up menu, the new one will be added at the beginning. 

 Add Component – Add a Component at the selected Segment.  
 Remove – Remove the selected Segment or the Component. 
 Rename – Rename the selected Segment or the Component. 
 Resize – Resize the selected Component. 

 
To create an Advanced Analog Waveform: 

 Follow the steps 1-6 of the Arbitrary Mode Single Sequencer Setup Example.  

 The New Waveform window is shown. Type the name of the waveform “Wave1” and 
choose 10k for the samples length of the waveform. Click OK to confirm. 

 

Figure 78  New waveform window 

 The Editing Waveform Window is shown. Right click on Segment1 of the Wave1-0 to 
open the pop-up menu. 
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Figure 79  Editing waveform window 

 Select Properties on the pop-up menu. 
 Change the segment length: insert 2.5k in the New Length field. 

 
Figure 80  Property window 

 The Wave1-0 and the Segment1 will be resampled to the new length. 
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        Figure 81  Waveform editing 

 Select the Segment1 and click the Edit button on the toolbar, the Standard Waveform 
Editor window is sho

 
Figure 82  Standard Waveform Editor 

 Select Triangle as waveform Type and 4 as number of Cycles. 
 Click OK. 
 Right click on the Segment1 of Wave 4-0 to open the pop-up menu and select Add 

Segment. 
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Figure 83  Add segment 

 The Property window is shown. Select 2.5k as Segment2 length and change the color. 
 Click OK. 
 Right click on the Segment2 of Wave4-0 to open the pop-up menu and select Add 

Segment. 
 The Property window is shown. 
 Select 5k as Segment3 length and change the color. 
 Click OK. 
 Select the Segment3 and click the Edit button on the toolbar. 
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 The Waveform Standard Editor is shown. Select Sinc as waveform Type. Click OK. 
 

 

 

 

Figure 84  Waveform standard editor 
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 Right click on the Segment3 of Wave4-0 to open the pop-up menu and select Add 
Segment. 

 Right click on the Component1/Segment2 of Wave4-0 to open the pop-up menu and 
select Add Component 

 
Figure 85  Add component 
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 Select the Component 2 and press the Edit Waveform button. The Standard Waveform 
Editor window is shown.  

Figure 86  Editing waveform 

 Select Cosine as waveform Type and Multiply as Operation. 
 Press OK. 
 The Advanced Waveform is ready to use and can be inserted in the Sequencer. 
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Digital Waveform Editor  

AWG4162 can be configured to work as a powerful Digital Pattern Generator. 

In this working mode AWG4162 provides the capability to emulate standard serial or parallel bus 

transitions or custom digital interfaces for system debugging and characterization. 

Pay attention to the following: 

 The Max  vector memory depth is 32Mpoints /Ch. 

 In Arbitrary Mode the maximum update rate is 1.25GS/s on 16 channels workspace and 625 

MS/s on 32 channels workspace. 

 Alignment between Digital and Analog Channels: by using the de skew controls on the 

Settings Tab, it is possible to realign the analog channels with a resolution of about 10ps and 

the digital channels with a resolution of about 78ps. 

Single signals are visualized as digital signals, while grouped signals are represented as buses. 

When you create a New Mixed or Digital Waveform you have single digital signals at your 
disposal; the number and the names of those signals depend on the initial Project setup. 
You can change the name of the signals and create / rename buses pressing the Group Digital 

Signals  button on the Digital Channels Settings Tab. 

Figure 87  Digital waveform editor 

Common operations can be directly performed on digital single signals or buses (Selection, Left 
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Click, Right Click). Drag and Drop operation between digital waveforms is not allowed. 
 
LEFT CLICK AND SELECTION 

 Left Click on the Signals cell to select the entire digital single signal or bus that will be 
enlightened in blue.  

 Click and drag inside the graph area to create a rectangle delimiting the digital 
waveform section. You can apply one of the operations described in the Digital 
Waveform toolbar on the current selection or on the entire waveform. 

 Left Click on the Signals cell tree item to open/close the bus. 
 Resize the digital signal amplitude by dragging the line between a signal name cell. 
 To the right of every analog signal, a number indicates the value the signal or bus at the 

time position of the master cursor. 
 

RIGHT CLICK 

A Right Click on a Digital Waveform tree item activates a pop-up menu, with functions depending on 
a Waveform or Segment selection as follows. 

  

Figure 88  Pop-up menu 

 Analog mode display - This option (available only for the buses) will represent a bus as an analog 
waveform. This is useful for example if an ADC or a DAC has to be tested. 

 Properties- Open the digital waveform Property Window. You can use it to change signals/buses 
colors, plot height and the display format of the bus value. 

 
Figure 89  Signals property 
 LSB on Top - Bus values are calculated with MSB (Most Significant Bit on Top) by default. 

Select LSB to have the Least Significant Bit on Top instead. 
 Copy - Copy Waveform. Select the entire waveform clicking on the signal/bus name on 

the left column or select a portion of it with mouse selection. 
 Paste - Paste Waveform. Paste the copied waveform into a selected area of the graph 
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(mouse selection) or from the start of another waveform. 

 

Data Editor 

The Data Editor can be used to edit analog/digital signals and bus values in tabular format. Data is 

visualized numerically in columns when using the Data Editor.  

The Data Editor contains the following two additional columns: 

 Samples - Contains the progressive number of the samples generated. 

 Time - Contains the progressive absolute time of every sample. 

BUS 

A bus node is indicated by the Expandable Bus icon shown to the left of the bus name (in the 

columns on the right of the screen). 

Expanding an analog waveform, the Segments are shown. Expanding a Segment, the Components 

are shown. 

Expanding a digital waveform, the single digital lines are shown. 

Double click the bus name to open the bus. 

Once a bus node is opened, the Expanded Bus icon is shown instead of the Expandable Bus icon.  
Double click the bus name again to close the bus. 
 

 
Common operations can be directly performed on table values (Selection, Left Click, Right Click). 
Drag and Drop operation between table columns is not allowed. 
 
LEFT CLICK AND SELECTION 

 Left Click on the signal name to select the entire analog/digital single signal or bus that 
will be enlightened in blue.  

 Click and drag inside the table cells to create a rectangle delimiting the analog/digital 
waveform section.  
You can apply one of the operations described in the Analog/Digital Waveform toolbar 
on the current selection or on the entire waveform. 

 Keep pressed the left mouse button on single cell to edit the value. 
 Resize the column amplitude by dragging the line between a signal name. 

 
 

RIGHT CLICK 

A Right Click on a table cell activates a pop-up menu, with functions depending on a 
Analog/Digital Waveform selection as follows. 
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Figure 90  Pop-up menu by right-click 

You can change table values by pressing Digital Editor Waveform toolbar buttons or right 
clicking on a table item to open the context menu. 
To Export data, select the Export data… right click menu item or click on the export menu icon 

  . 
The digital data will be exported into a .txt file; the file is comma separated with an header on 
the first line. 

To Import data, select the Import data… right click menu item or click on the export menu icon 

  . 
The digital data import format is .txt ; the file is comma separated with an header on the first 
line. 
Please pay attention to the following: 

 The disabled cells in the Digital single signals/buses are not editable. 

 The changes made on the table cells are also shown on the Mixed Waveform Editor directly 

above it. 

You can change table values by pressing Analog Editor Waveform toolbar buttons, changing the 
values on the data grid. As shown in the following figure, right-click on a table item to open the 
context menu using the Select Waveform … item; if you select some values on the data grid 
and use the Edit… option, the Waveform Standard Editor window will open and you can 
change the values directly on the table. 
Effects… menu item will open the Filter & Noise window and Search… item will open the 
“Search Settings” window. 

 
To Export data, select the Export data… right click menu item or click on the export menu icon 

  . 
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Figure 91  Right-click on an item 

The analog data will be exported into a .txt file; the file is comma separated with an header on 
the first line that represents the Sample rate and the number of samples. 
# Sample rate: 2.5E+09 

# Samples: 16000000 

To Import data, select the Import data… right click menu item or click on the import menu icon 

  . 
 
 
 

 

Sequence Window
It is sometimes necessary to create long waveform files to fully implement a DUT test. Where 

portions of the waveforms are repeated, a waveform sequencing function can save you a lot of 

memory-intensive waveform programming. 

The Sequencer allows you to select which edited waveforms are generated, their sequence, number 

of repetitions and the generation conditions. 

Sequencer is used for mainly the following two purposes: 

 Output longer waveform than hardware memory. 

 Change the output waveform quickly following conditions. 
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Figure 92  Sequence 

A sequence is made of multiple entries; each entry contains analog and digital signals properly 

formatted. 

It is possible to create a subset of entries identifying a Subsequence that can be placed into the 

Sequencer entry by mouse drag & drop. In the picture above the entry 3 of the sequencer is 

replaced by a Sub-Sequence with 3 entries. 

Pay attention to the following: 

 The digital waveform length must be 1/2 or 1/4 of the analog waveform length in the same 

sequencer entry. 

 A subsequence can be placed into the sequencer in the same way as a waveform by 

dragging and dropping the SubSequence from the Subsequences TAB into the sequencer. 

 The Subsequence entry does not have the Wait Event option. 

 If you select the Jump Event option in the main subsequence entry and the first element of 

the subsequence has Wait Event or Jump If Event selection, the main sequence has the 

higher priority on all the entries of the Subsequence.  

 To create a new SubSequence press the “New Subsequence” button located in the toolbar 

aside the SubSequences tab.  

 A Subsequence can be edited exactly in the same way as the main sequence. 

 It is not possible to have a Subsequence with just one entry. 

 The maximum number of entries in the sequencer is 16384. 

 

 

 

   ∞ 

Entry 3  

     4 Jump if 

Event 0 

Wait Event 

0 

SubEntry 1 SubEntry 2 SubEntry 3 

Entry 1 

(square) 

Entry 2 

(sine) 
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When the waveform or the subsequence is dropped into the sequencer a dialog box, as shown in 

the following.  You can specify the properties of the new sequencer entry that is going to be created. 

 

 Figure 93  Input Waveform Properties 

Input Waveform Properties 

1. An entry can be repeated if the Wave Repetitions is specified. 

Press the  button for infinite repetitions.  

2. If an event is selected in the Wait Event drop-down list (Event0..Event7 are available), the 

sequencer will wait for the Event N before generating a waveform. 

3. Jump Event changes the sequencing of the waveform by the event specified in the Jump 

Event drop-down list. Event0...Event7 are available. 

If the Jump Event has been set inside a Subsequence entry, when the event occurs the 

Sequencer will exit from the Subsequence and it will continue the entry generation in the 

main sequence. 

4. Jump Address sets the number of the entry at which the Sequencer will jump when the 

event occurs. 

5. Jump Type: if Sync is selected and the event occurs, the sequencer waits for the end of the 

current waveform before executing the Jump.  

If Async is selected, the sequencer executes the Jump as soon as the event occurs.  

6. Go to Address: if Jump Event is not selected (Event7 None), the sequencer will execute the 

next entry after the completion of the current one.  

You can change the execution order pressing the checkbox to activate the Go to Address 

control and type the next entry address.  

1 

2 

3 

6

. 

4

. 
5

. 
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Pay attention to the following: 

 The infinite repetitions have the priority over the Go To Address. 

 It is possible to set Wait Event AND Jump If Event conditions in the same entry; the 

Jump If condition is evaluated after that the Wait Event has occurred. 

 The Jump instruction cannot be evaluated during the transition between the current 

and the next entry. 

 The header of the entry contains the settings of the Input Waveform Properties window. 

 

Figure 94  Waveform settings 

R :4  =  4 repetitions 

W :7 =  Wait for Event 7 (None) 

J: 7   =   Jump if Event 7 (None) 

JA:1 =   Jump Address 1 

JT:A =  Jump Type Asynchronous 

G:1 = Go To Address 1 
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Main Sequencer window 

When Sequence is selected in the Run Mode, multiple waveforms can be output in the order 

specified in the Sequence Window. The Sequence Window displays the analog and digital 

waveforms that will be generated. 

 

Figure 95  Single main sequencer 

Single Sequencer workspace has one sequencer called Main Sequencer that controls all 

analog/digital channels waveform generation.  

Multi Sequencer workspace has two Sequence Windows: the first one is relative to the Analog 

Output 1, the second one is relative to the Analog Output 2. Each one works independently by the 

other and has its own list of available waveforms in the Waveform TAB.  
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Figure 96  Multi main sequencer 

Pay attention to the following: 

1. If you click on a cell in the Sequence window, the selected waveform is displayed in the 

Waveform View window. The background color of the selected cell changes in blue. 

2. If you click on the header of the cell in the Sequence window, the entry is selected and all 

the waveforms inside it are displayed in the Waveform View window. The background color 

of the selected entry changes in blue. 

3. Drag a waveform from the Waveform List window and drop it to a cell of the Sequence 

window to insert it in the sequencer. 

4. To edit a waveform: after selecting a cell in the Sequence window, right click to open the 

pop-up menu and select Edit Waveform to open the Editing Waveform Window.   

5. When you insert a waveform in a sequencer cell, its maximum and minimum levels are 

displayed on the left margin of the cell. 

6. When Continuous, Triggered, or Gated is selected in the Run mode, the Sequence window 

contains one waveform only. 

 

 

 

 

Sequencer AO2 Sequencer AO1 

Maximum and 

minimum levels 
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Click on the “Table” Tab for 

the Sequencer Table View 

Waveform and Table View of the Sequencer 

NOTE:  

The sequencer provides both a Waveform and Table view of your sequenced waveforms. Both views provide the 
same data; however, Waveform provides a graphical representation of your sequence, while the Table shows a 
list. 

 

Figure 97  Table view of the sequencer 

 

 

  

Waveform entry properties 
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Editing a Sequence 

 

 

Figure 98  Sequence editor 

The Sequence Window allows you to select waveforms from the Waveforms tab for generation by 

the AWG4162 instrument.  

Drag a waveform from the Waveform TAB to a cell of the Sequence window to insert it in the 

sequencer. Remove waveforms from the Sequencer using the Sequence Window Toolbar.  

 

Sequence Window Toolbar 

 

 

Edit Entry – opens the Input Waveform Property 
window  

 

Remove selected entry – removes all the 
waveforms in the selected entry from the 
sequencer. 

 

Remove all – removes all the entries from the 
sequencer. 

 

Waveform/Table – switches the sequencer 
visualization from waveform to table style. 

 
Memory Usage – indicates the percentage of 
available memory for waveform generation. 

  

 

Click to toggle between 

Waveform and Table views. 

Entry/Subsequence number 

of repetitions and length Analog and Digital Waveform name 
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A Right Click on a Waveform cell activates a pop-up menu 

 
 Edit Entry:  opens the Input Waveform Properties window to change the current entry 

properties. 

 Remove: removes all the waveforms in the selected entry from the sequencer. 

 Remove all: removes all the entries from the sequencer. 

7. Edit Waveform: opens the Editing Waveform Window to make changes on the selected 

waveform. 

How to Create a Sequence 

Prerequisites: 03_JumpIfRepeat_Wait_Sequence project is ready. 

 

 

Figure 99  Sequence editor 

1. Open the demo Jump project 03_JumpIfRepeat_Wait_Sequence from C:\Program Files 

(x86)\Tektronix\AWG4000 Advanced\DemoProjects. (This is default Advanced APP install 

path. If user install Advanced APP in other path, then you should open form InstallPath\ 

DemoProjects ) 

2. Press the  button in the Sequence Window toolbar to remove all the sequencer entries. 

 

 

 

 

  

   ∞ 

Entry 3  

     4 Jump if 

Event 0 

Wait Event 

0 

SubEntry 1 SubEntry 2 SubEntry 3 

Entry 1 

(square) 

Entry 2 

(sine) 
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3. On the Waveforms tab, drag the Square waveform and drop it in the first entry of the 

sequencer. 

 
Figure 100 Dragging the waveform 
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4. On the Input Waveform Properties window select infinite repetitions and Event0 (Force 

Trigger AND True AND True AND True) in the Jump Event drop-down list. 

The Jump Event and Address control is disabled because there are not entries in the 

sequencer yet. Will change it in step9. 

Press OK to confirm. 

 

 Figure 101 Edit waveform entry 1 
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5. On the Waveforms tab, drag the Sine waveform and drop it in the second entry of the 

sequencer. 

 
Figure 102  Dragging the waveform 
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6. On the Input Waveform Properties window select 4 repetitions, mark the Go To Address 

checkbox and type 1 as Go To Address value. Press OK to confirm. 

 

Figure 103 Edit waveform entry 2 
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7. On the Subsequences TAB, drag the Subsequence1 and drop it in the third entry of the 

sequencer. 

 

Figure 104  Dragging the Subsequence 
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8. On the Input Waveform Properties window select 1 repetitions, mark the Go To Address 

checkbox and type 2 as Go To Address value. Press OK to confirm 

 
Figure 105 Edit waveform entry 3 
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9. Now the sequence is complete but you need to modify the properties of the Entry 1; double 

click on the Entry 1 or right click to open the pop-up menu and select Edit Entry. 

Set Event0 (Force Trigger AND True AND True AND True) in the Jump Event drop-down list. 

Modify the Jump Address field and type 3 as address of the jump. Press the OK button to 

confirm. 

 
Figure 106  Edit waveform entry 1 
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10. The last step is to set wait event 0 to the subentry 1 of Subsequence 1. 

Press the   Sequence/Subsequence button to select Subsequence 1. 

 
Figure 107 Waveforms of Subsequence 1 

 

Then double click on the Entry 1 or right click to open the pop-up menu and select Edit 

Entry.  
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11. On the Input Waveform Properties window, set Event0 (Force Trigger AND True AND True 

AND True) in the Wait Event drop-down list. Press OK to confirm  

 
Figure 108 Edit waveform subentry 1 
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How to Create a Subsequence 

Prerequisites: 03_JumpIfRepeat_Wait_Sequence project is ready.  

1. Open the demo Jump project 03_JumpIfRepeat_Wait_Sequence from C:\Program Files 

(x86)\Tektronix\AWG4000 Advanced\DemoProjects. (This is default Advanced APP install 

path. If user install Advanced APP in other path, then you should open form InstallPath\ 

DemoProjects ) 

2. On the Sequences TAB press the  New Subsequence button. 

3. The new empty subsequence is shown on the Main Sequencer Window (Subsequence 2) 

 

Figure 109  New empty subsequence window 
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4. Drag a waveform from the Waveform TAB to a cell of the Sequence window to insert it in 

the sequencer. The destination sequencer cell of the selected waveform will be enlightened 

in red. 

On the Input Waveform Properties window, select 1 repetitions. Press OK to confirm 

 

 
 

Figure 110  Dragging the waveform 
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5. Repeat the last step Square and Sync waveforms. The Subsequece2 is made of three entries: 

Wave1(Square), Sweep and Sinc Mixed waveforms. 

 

Figure 111  Waveforms of subsequence 2 

6. Press the   Sequence/Subsequence button to close the subsequence, 

confirm the changes and return to the main sequencer. 

The Subsequence2 will appear in the Sequences TAB and now you can insert it into the Main 

Sequencer. 
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Waveform View Window 

 
A selected element in the Sequence Window is displayed in the Waveform View window. 

To the left of every signal, there are two columns: the first one called Signals displays the name and 

the root icon to open/close the segment/component/bus elements, the second one called Value 

displays a number indicating the value the signal at the time position of the master cursor. 

1. If you select a single cell, you can use the Waveform View window to display analog and 

digital waveforms. 

 

Figure 112  View the waveforms 
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2. If you click on the header of the cell in the Sequence window, the entry is selected and all 

the waveforms inside it are displayed in the Waveform View window, as shown in the 

following.  

 

Figure 113  View the waveforms 

When viewing a waveform in the Waveform View Window, you have access to the following 

functions: 

 

 

This button allows changes the mouse function for the graphic 
area to cursors/markers movement. 

 
The hand tool allows you to dragging inside the graph area. 

 

 

Auto zoom in function. 

 
Auto zoom out function. 

 
This button allows zooming in on a selected rectangle of the 
graph. Click and drag inside the graph area to create your 
zoom rectangle. 

 

This button resets all activated zooms 

 

You can change the properties of the graph display area. Click the 
Waveform View Settings button and the 
Graph Property screen is shown. 
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Changes can be made as follows: 

   The Background Color can be changed as desired. 

   Change colors and turn the Major and Minor Grids on or off 
and change their line coloring. 

   Cursor Position indicators can be turned on or off. 
 

 

This button switches the X-axis representation between number 
of samples to seconds. Default values are optimized based on 
the selection made. 

 
  



www.tektronix.com   

138 
 

Tutorials 
Scenarios with detailed steps for performing typical tasks and setups using AWG4162 are shown in 

the Examples. 

How do I Examples 
PLEASE NOTE THE FOLLOWING: 

 Before performing any of the scenarios, you must first make sure you've correctly powered 

on your instrument, and launched the AWG4162 software as explained in the Getting 

Started section. 

 Some more specific steps are required around Creating a New Workspace for each scenario. 

Details are provided for those scenarios when necessary. 

With the aforementioned prerequisites completed, you can perform the following scenarios: 
1. Creating Your First Analog Waveform  

2. Creating a Sequence of Waveforms  

3. Importing a Waveform + Component Usage + Gated Run Mode  

4. Creating Digital Waveforms  

 

Creating Your First Analog Waveform 

 

After you have powered on the instrument, launch the software and use the system menu bar or 

the toolbar to create a New Workspace. 

1. Create  a Single Sequencer project with Arbitrary Waveform Generator as 

the Operating Mode. 

2. Click the New Mixed Waveform button. 
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3. The New Waveform window is shown. Type the name of the waveform “Wave1” and 

choose 2048 for the samples length of the waveform. Click OK to confirm. 

 

Figure 114  New waveform settings 

4. The Editing Waveform window is shown. Select the waveform Wave1-Ch AO1 and click on 

the Edit Waveform   button 

 

Figure 115  Editing waveform window 
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5. The Waveform Standard Editor is shown. Choose a sine waveform with the following specs: 

  Cycles: 2 

  Amplitude[V]: 250mV 

 

Figure 116  Standard waveform editor 

6.  Press OK button. 

7. Select the waveform Wave1-Ch AO2 and click on the Edit Waveform   button. 
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8. The Waveform Standard Editor is shown. Choose a rectangle waveform with the following 

specs: 

  Cycles: 4 

  Amplitude[V]: 300m  

 

 

Figure 117  Standard waveform editor 

9. Press OK button. 

10. Press OK button on the Editing Waveform window. 

11. On the main toolbar, press the Settings  button.  

12.  On the Settings pop-up screen’s Run Mode tab, select Continuous. 
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13. Click OK. 

 

Figure 118  Setting screen  
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14. Drag the Wave1 from the Waveform Area to the first cell of the Sequence Area (the selected 

cell is highlighted). 

 

Figure 119  Sequence window 

15. Now, press the Run/Stop button on the AWG4K toolbar. 

 
 

The software loads the waveforms into the AWG4K instrument and starts generating the 

waveforms. Wave1 is generated on the AO1 and AO2 SMA outputs. You can connect an 

oscilloscope to this output and analyze the signals. 

You can stop generating waveforms by pressing the Run/Stop button again. 

Creating a Sequence of Waveforms 

 

After you have powered on the instrument, launch the software and use the system menu bar or 

the toolbar to create a New Workspace. 
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1. Create a Single Sequencer project with Arbitrary Waveform Generator as 

the Operating Mode. 

  

 
 

Figure 120  Single sequencer project 

2. Add three waveforms to our Waveforms tab list.  

3. Assign the following specifications for waveforms 1, 2, and 3 on the Waveform Standard Ed

itor dialg box. 

Waveform 1 - Square waveform Type, 2048 Samples, 1 Cycle and 300 mv Amplitude. 

Waveform 2 - Sine waveform Type, 2048 Samples, 1 Cycle and 300 mVolt Amplitude. 

Waveform 3 – Triangle waveform Type, 2048 Samples, 1 Cycle and 300 mVolt Amplitude. 

4. Click the New Mixed Waveform button .  

5. The New Waveform window is shown. Type the name of the waveform “Square” and 

choose 2048 for the samples length of the waveform. Click OK to confirm. 

 

Figure 121  New waveform window 

Entry 1 

(square) 

   ∞      4 
Jump if 

Event 0 

Wait Event 

0 

Entry 3 

(triangle) 

Entry 2 

(sine) 
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6. The Editing Waveform window is shown. Select the waveform Square-0 and click on 

the Edit   button 

 

  

Figure 122  Edit waveform window 
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7.  The Waveform Standard Editor is shown. Choose a rectangle waveform with the following 

specs: 

  Cycles: 1 

  Amplitude[V]: 300mV 

        

Figure 123  Waveform standard editor 
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8. Press OK button. 

9. Press OK button on the Editing Waveform Window to close and confirm. 

       

Figure 124  Edit waveform 

10. Repeat the steps 4 ~ 9 to create the Sine and Triangle waveforms. The Square, 

Sine and Triangle will appear on the Waveform tab. 

11. On the main toolbar, press the Settings  button. On the Settings pop-up 

screen’s Run Mode tab, select Sequence. 
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Click OK. 

 

Figure 125  Setting screen 

12. On the Waveforms tab, drag the Square waveform and drop it in the first entry of the 

sequencer. 

13. On the Input Waveform Properties window select infinite repetitions. 

14. The Jump Address control is disabled because there are not entries in the sequencer yet. 

15. Press OK to confirm. 
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Figure 126  Input waveform properties  
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16. On the Waveforms tab, drag the Sine waveform and drop it in the second entry of the 

sequencer. 

17. On the Input Waveform Properties window select 4 repetitions, mark the Go To Address 

checkbox and type 1 as Go To Address value. Press OK to confirm. 

 

 
Figure 127  Input waveform properties 

18. On the waveforms TAB, drag the Triangle waveform and drop it in the third entry of the 

sequencer. 

19. On the Input Waveform Properties window select Wait Event0 and mark the Go To Address 

checkbox and type 2 as Go To Address value. Press OK to confirm.   
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        Figure 128  Input waveform properties 

20. Now the sequence is complete but you need to modify the properties of the Entry 1; 

double click on the Entry 1 or right click to open the pop-up menu and select Edit Entry.  

            

Figure 129  Input waveform properties 
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21. Modify the Jump Address field and type 3 as address of the jump. And set Event0 (Force 

Trigger AND True AND True AND True) in the Jump Event drop-down list. Press 

the OK button.  

22. Now, press the Run/Stop button on the AWG4K toolbar.  

  

23. The software loads the waveforms into the AWG4K instrument and starts generating the 

waveforms. The sequence is generated on the AO1 SMA output. You can connect an 

oscilloscope to this output and analyze the signal 

24. Stop generating waveforms by pressing the Run/Stop button again.  
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Importing a Waveform + Component Usage + Gated Run Mode 

 

Import a Waveform by first creating a project with Arbitrary Waveform Generator Mode.  

If you already have a workspace open, be sure it meets the aforementioned requirements before 

proceeding with the following steps: 

1. Click the New Mixed Waveform button.  

The NEW Waveform window is shown. Type the name of waveform”Wave1” and choose 

2048      for the samples length of the waveform. Chick OK to confirm. 

 
Figure 130  New waveform 
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2. The Editing Waveform Window is shown. Select the waveform Wave1 and click on the Edit 

Waveform   button. 

 

Figure 131  Editing waveform window 



www.tektronix.com   

155 
 

3. On the Type drop-down list select From File… and press the Load… button. 

The Import waveform pop-up screen is shown as follows. 

 
Figure 132  Input waveform properties 

 

          Labels A-E on this image corresponds with the following descriptions: 

A.      Click the Browse button and locate your desired .txt file for import. 

B.      The File parsed section then shows the first 100 samples of the imported waveform. 

C.      If desired, Input file settings allow for Sample rate, Header lines to remove, and Decimal           

separator changes to the imported file. 

D.      Use the Sample setting fields to adjust parameters and rules. 

E.       If the imported waveform has a sample rate greater than the AFG4K target sampling rate 

(2.5 GS/s), the waveform points are re-sampled and shown on the Sampling information fields. 
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4. Browse from C:\Program Files\Tektronix\AWG4000 

Advanced\SCPI\AWG4KImportWaveforms\Sine0.txt file  

 

Figure 133  Browse waveform 

 

5. Click OK to confirm. Waveform Standard Editor window is shown and it displays the 

imported waveform. 

  

Figure 134  Waveform standard editor 
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In the following steps we will use a DC component to multiply it by a constant and change 

current waveform voltage. Click OK to confirm. 

 

6. Right click on the Wave1 Component1 to display the pop-up menu and select Add 

Component. 

 

Figure 135  Edit waveform 

Component2 is added to Wave1-Ch AO1  
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7. To Component1, select Multiply in the Operation field. 

To Component2, select DC Level as Type and 1.2 in the Offset[V] field as multiplication 

factor. 

 

Figure 136  Edit waveform 

The Wave1-Ch AO1 = Component1*Component2. The waveform amplitude of Wave1-Ch AO1 

has been increased by a 1.2x factor. 
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Figure 137  Edit waveform 

8. Click OK to confirm 

9. On the Settings pop-up screen’s Run Mode tab, select Gated. 

10. Click OK. 

 
Figure 138  Setting screen 
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11. Drag the Wave1 from the Waveform Area to the first cell of the Sequence Area (the selected 

cell is highlighted). 

 
Figure 139  Edit waveform sequence 

 

12. Now, press the Run/Stop button on the AFG4K Toolbar. The software loads the waveforms 

into the AFG4K instrument.  

 

13. Keep pressed the  button to start the waveform generation. 

Wave1 is generated on the AO1 and AO2 SMA outputs.  

14. Release the  button to stop the waveform generation. 

You can connect an oscilloscope to this output and analyze the signals. 

15. Stop the instrument by pressing the Run/Stop button again. 
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Creating Digital Waveforms 

 

The AWG4K may optionally be configured to work as a powerful Digital Pattern Generator. 

When the AWG4K runs in this mode it can emulate standard serial or parallel bus transitions or 

custom digital interfaces for system debugging and characterization. 

After you have powered on the instrument , launch the software and use the menu bar to 

create a New Workspace.  

 

Figure 140  New workspace 

 

 NOTE:  

The following steps are done with Pattern Generator operation enabled. 

 

1. Type the Workspace name. 

2. Select Single as Sequencer Mode. 

3. Select Arbitrary as Channel Functionality. 

4. Select 32Ch@625 MS/s as Digital Channel Speed.  
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NOTE:  

Two Infinite band 12x connectors provide 16 bit LVDS digital outputs each for a total of 32 LVDS outputs. 
These digital outputs can be software configured to operate in different ways. 

In ARB mode it is possible to operate with all of the 32 channels with a maximum update rate of 625MSps or 
with half channels (16) at 1.25Gsps. 

 

5. Click OK.  

6. On the main toolbar, press the Settings button. Then click the Group Digital Signals button.  

 
Figure 141  Settings 
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7. The Digital Logical name and Grouping window is shown. 

 
Figure 142  Digital Logical name and Grouping window 

Now, let's make a bus by selecting DO0..DO7 on the channel list on the left, and then 

clicking the Group Selected. Keep pressing the left mouse button on the bus root name to 

change its name to ADDR.  

Repeat the procedure for DO8..DO23 and change the group name to DATA.  

Rename the DO24 to RD, the DO25 to WR and the DO26 to CLK.  

 

8. Click the New Mixed Waveform button . 

9. The New Waveform window is shown. Type the name of the waveform “Wave1” and 

choose 10K for the samples length of the waveform. Click OK to confirm. 
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  Figure 143  New waveform 

 

 

10. The Editing Waveform Window is shown. 

 

Figure 144  Editing waveform window 



www.tektronix.com   

165 
 

11. Select the CLK row and use the Clock Button to modify settings on the corresponding pop-

ups. 

 
Figure 145  Editing waveform 
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12. Now, define WR and RD signals similarly, by selecting a portion of the digital channel 

graph, and clicking the desired button from the following choices: 

 
Figure 146  Editing waveform  
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13. Now define the ADDR bus by selecting the ADDR row and use the Counter Button to 

modify settings on the corresponding pop-ups. 

 
Figure 147  Define the ADDR bus 



www.tektronix.com   

168 
 

14. Now, define DATA bus signals, by selecting a portion of the data bus 

graph, and clicking the value button: 

 
Figure 148  Define the DATA bus  

15. Click OK to close the Editing Waveform Window. 

16. On the Settings pop-up screen’s Run Mode tab, select Continuous. Click OK. 

 
Figure 149  Editing waveform 

17. Drag the Wave1 from the Waveform Area to the first cell of the Sequence Area (the 

selected cell is highlighted). 
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Figure 150  Drag Wave1 

 

18. Press the Run/Stop button on the AWG4K toolbar. 

 
The software loads the waveforms into the AWG4K instrument and starts generating the 

waveforms.  

Wave1 is generated on the Pod A and Pod B probes. You can connect a logic analyzer and 

analyze the generated signals. 

Wave1 analog signals are generated on AO1 and AO2 SMA outputs. 

You can connect an oscilloscope to this output and analyze the signals. 

 

19. Stop generating the  waveforms by pressing the Run/Stop button again. 
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Common Tasks Examples 
In addition to these How do I Scenario Details, there are some common tasks for your reference.  

1. Creating a New Workspace  

2. Opening an Existing Workspace  

Pay attention to the following: 

Some more specific steps are required when creating a new workspace for each scenario. Details are 
provided for those scenarios when necessary. 

Create a New Workspace 

1. Click File->New Work Space 
2. Type the Workspace name   
3. Select Location. There are two locations: Normal Area and Security Area. If you select 

security area, when you execute “Secure” function in Basic App, all the data in security 
area will be erased completely. 

4. Select Single as Sequencer Mode 
5. Select 16Ch@1.25 GS/s as Digital Channel Speed.  

 

NOTE:  

Two Infiniband 12x connectors provide 16 bit LVDS digital outputs each for a total of 32 LVDS outputs. 
These digital outputs can be software configured to operate in different ways. The digital channels are 
available with Digital Option installed only. 

It is possible to operate with all of the 32 channels with a maximum update rate of 625MSps or with half 
channels (16) at 1.25Gsps. 

 

 

6. Click OK. 
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 Figure 151  Setting the new waveform 

 

7. Click the New Mixed Waveform button. 

 
8. The New Waveform window is shown. Type the name of the waveform “Wave1” and 

choose 2048 for the samples length of the waveform. Click OK to confirm. 

 
Figure 152  New waveform 

9. The Editing Waveform window is shown. Select the waveform Wave1-0 and click on the 

Edit   button. 
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Figure 153  Editing waveform 

10. The Waveform Standard Editor is shown. Choose a sine waveform with the following 
specs: 

 Cycles: 2 
 Amplitude[V]: 250mV 

11. Press OK button. 

12. Select the waveform Wave1-1 and click on the Edit   button. 
13. The Waveform Standard Editor is shown. Choose a triangle waveform with the following 

specs: 
 Cycles: 4 
 Amplitude[V]: 1V  
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  Figure 154  Waveform standard editor 

14.  Press OK button. 
15.  Press OK button on the Editing Waveform window; the Wave1 will appear on the 

Waveform TAB. 

16. Click the  Settings button. The Settings window is shown. 

Figure 155  Settings window  
 

17. Select Sequence as Run Mode  
18. Select the Analog Ch AO1 TAB and select DC Direct as Out Type 
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Figure 156  Settings window  
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19. Select the Analog Ch AO2 TAB and select DC Amplified as Out

 

 Figure 157  Settings window 

20. Press OK button. 
21. Drag the Wave1 from the Waveform Area to the first cell of the Sequence Area (the 

selected cell is highlighted). 

22. The Input Waveform Properties is shown. Click the  button to set infinite 
repetitions on Wave1. The item flowchart will help you to understand the correct 
behavior of the instrument.  

 
Figure 158  Input window properties 

23. Press OK button. 
The Sequence Area shows now the Wave1 inserted in the first cell. If you select one of the 

waveform, it appears on the Waveform Display Area placed below. 
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25. Press the Run/Stop toolbar button. 

NOTE:  

Once the instrument has started, Sequence Run Mode with infinite repetitions, repeats Wave1 until the 
Run/Stop button is clicked again. 

 

The software loads the waveforms into the AWG4162 hardware and then generates 
waveforms. 

26. Wave1 is exported to the CH1/CH2 SMA output, which can be connected to an oscilloscope 

for signal analysis.  The output are 50ohm single ended or 100ohm differential, oscilloscope 

termination must be set accordingly to ensure proper observation. 

 
 
 

 

Open an Existing Workspace 
 

1. Open existing workspaces by clicking the Open Workspace toolbar button. The Open 

Workspace screen is shown. 

2. The Open Workspace screen automatically navigates to the Awg4KWorkspace folder. Select 

the workspace and click Open. 

 

Demo Project 
1. The AWG4162 setup automatically installs under the folder C:\Program Files(86)\ 

Tektronix\AWG4000 Advanced\DemoWorkspace several demo workspace that can help 

you to understand more in depth all the instrument features. 

2. Note that the Demo Workspace are configured for a full optional instrument (64MS/CH and 

32 DIOs), so if you try to open them with a connected instrument with less options, you will 

receive an error message. 
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Option Installation 
There are some options. They relate with Memory size and Digital bits: 

MEM64 
MEM32 
MEM16 

MEM01 

DO32 

DO16 

 

Use the License Manager dialog box to enable the upgrades that you purchased from Tektronix for 

your instrument. For the most current list of upgrades, go to www.tektronix.com or contact your 

local Tektronix representative. 

1. Press Help > License button to open the License Manager dialog box. 

2. The dialog box will show you the current license codes loaded into the instrument. 

 
Figure 159  License codes 

3. Press the Add New License to open Add New License Code dialog box. 

http://www.tektronix.com/
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Figure 160  Add a new license 

4. Enter the Option Installation Key provided by Tektronix or load it form file using the Load 

License File button. 

 

Figure 161  Load a license 

5. Press the OK button to load the new license code into the instrument. 
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Multi-Instrument System 
 

You can connect two AWG4162 units to have a system with 4 synchronized analog channels and up 

to 64 digital channels. 

In order to set up a Multi-Instrument system you must first: 

 Turn off the instruments. 

 Select the instrument that you want to use as Master, the other unit will be considered as 

Slave. 

 Using the Sync Cable, connect the Master Sync Out connector to the Slave Sync In 

connector you can find on the rear of the instruments. 

 
Figure 162  Rear of the instrument 

 
Figure 163  Connecting units 

 Turn on the instruments. 

 Launch AWG4162 Advanced software 

  

http://www.tektronix.com/


www.Tektronix.com 
   
 

180 
 

NOTE:  

1. The Multi-Instrument System is available with Single Sequencer workspace only.  

2. Before connecting or disconnecting the sync Cable, you must turn off the instruments. 

3. The waveform length and sequencer must be the same in all the instruments (master+slave) connected 
using the Multi-Instrument System sync feature. 

4. The external sampling clock and external reference clock are available in Master device only. 

 

 

The following steps describe the steps that you should perform to set up a Multi-Instrument project 

and start the generation on two devices. 

1. On Master and Slave unit, launch the Advanced software and create a Single Sequencer 

project. 

2. The communication between Master and Slave has started: on the Master device the 

Capture button   is enabled. 

Figure 164  Master device 

3. Create one Mixed waveform (square wave, 0.6Vpp, 2048 points) on Master and Slave units. 

http://www.tektronix.com/
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4. Add the “Wave1” waveform into the sequencer. 

Figure 165  Slave device 

5. Even if Sync Cable has been connected, at the start-up the two devices works independently 

and you can use them as two separate devices; in this case the “crown” icon  will appear 

both in Master and  icon will appear Slave unit on the Multi-Instrument bottom status 

bar.  The Slave unit has not been captured yet, so  icon will appear on the status bar. 

 

On the Multi-Instrument bottom status bar there are icons that represents the status of the 

Multi-Instrument system. 

 

 

It represents the Master device. 

 

It represents the Slave device. 

 

There is another unit connected backward to the current instrument. 

 
There is another unit connected forward to the current instrument. 

 
There is not another unit connected backward to the current instrument. 

http://www.tektronix.com/
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There is not another unit connected forward to the current instrument. 

 
The Slave device has been captured by the Master. 

 

The Slave device has not been captured by the Master. 

 
The instrument is stopped. 

 
The instrument is running and the waveform generation has started. 

6. Press the capture button on the Master device to link the two instruments:  

  
Figure 166  Capturing a slave device 
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7.  

Figure 167  A slave device captured  

If you check the Salve Multi-Instrument Status bar, you will notice that the  icon indicates that 

you are on the Slave device, the blue arrow tell you that there is a device connected backward (the 

Master) and the  icon indicates that the Slave has been captured by the Master. The Slave 

instrument is stopped . 
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The two instruments now works linked together and the four channels will be synchronized; the 

Run/Stop button on the Slave device disappears because the Run/Stop will be controlled by the 

Master, as shown in the following figure, moreover the Timing settings and the Events settings are 

not available in the Slave since the sampling rate and the events are both Master controlled.  

 
Figure 168  A slave device controlled 

8. Press the RUN button on the Master device, the  “Load configuration …” form will appear: 

this form informs you that the Slave instrument (Device 1) is loading its configuration in 

terms of settings,  sequencer and waveforms and as soon as it will be ready, the Start button 

will be enabled. 

Please note that the “load configuration” procedure may fail due to wrong settings on the 

slave device, but this will not block the possibility to start the instruments indeed. 

 

 

Figure 169  Load configuration 
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9. Press the Start button to start the waveform generation on Master and Slave device. 

 

If you need the instruments to work as two independent devices, you should press the 

Release button   on the Master device. After you press it, the Run/Stop button, the 

events and the timing settings will appear again on the Slave unit. 

 

Appendix  

A. Digital Outputs 
The AWG4000 can output 16-bit (from Pod A) or 32-bit (from Pod A and B) of digital patterns with 

option DO16 or DO32. All bits are differential pairs in LVDS. The digital outputs can be configured as 

high speed or low speed mode in the Advanced Mode application. 

In high speed mode, only the 8 lsb’s (D0-D7) are available on each pod. The bit rate is half of the 

sampling rate (for example, 1.25 Gb/s at 2.5 GS/s sampling rate). 

In low speed mode, all 16 bits on each pod are available. The bit rate is a quarter of the sampling 

rate (for example, 625 Mb/s at 2.5 GS/s sampling rate). 

To ensure the best signal integrity when transmitting such high speed digital signals, a customized 

digital cable (AWG4DIG16LVDS) and the corresponding connector (AWG4DIGSCKT) mounted on the 

DUT are required. 

The AWG4DIGSCKT is an off-the-shelf part from Amphenol with part number U65-B12-41E0C, which 

a user can either buy from Tektronix, Amphenol or its distributors. 

The below graph and table show the PCB layout and pin definitions of the AWG4DIGSCKT mounted 

on the DUT. Please follow the manufacturer’s guidelines for PCB and mechanical designs 
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Figure 170  PCB layout 

Pin Description 

S1 NC 

S2 NC 

S3 NC 

S4 NC 

S5 NC 

S6 GND 

S7 NC 

S8 GND 

S9 D15_P 

S10 D15_N 

S11 D14_P 

S12 D14_N 

S13 D13_P 

S14 D13_N 

S15 D12_P 

S16 D12_N 

S17 D11_P 

S18 D11_N 

S19 D10_P 

S20 D10_N 

S21 D9_P 

S22 D9_N 

S23 D8_P 

S24 D8_N 

S25 D7_P 

S26 D7_N 

S27 D6_P 

S28 D6_N 

S29 D5_P 
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S30 D5_N 

S31 D4_P 

S32 D4_N 

S33 D3_P 

S34 D3_N 

S35 D2_P 

S36 D2_N 

S37 D1_P 

S38 D1_N 

S39 D0_P 

S40 D0_N 

S41 NC 

S42 GND 

S43 NC 

S44 GND 

S45 NC 

S46 NC 

S47 NC 

S48 NC 

G1~G25 GND 

M1~M4 GND 

 

Note: All NC pins MUST be left floating 
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B.Touch Panel Calibration 
1. Double click “Microchip AR Configuration Utility” on the desktop  

2. Choose “Configuration Wizard” 

 

 Figure 171  Microchip AR Configuration Utility  
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3. After click next will show below dialog, please choose “AR1100 Dev Kit” 

 
Figure 172  Choose “AR1100 Dev Kit” 
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4.   After that will show the dialog as below, please choose “USB” and “Digtizer”, and please 

wait. 

 

 

      Figure 173  Choose “USB” and “Digtizer” 
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5. Please click next until show below dialog, after that please click “Next”, and Finished 

 

 

Figure 174  Finish configuration 

6. Please close this application.  
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7. Please double click  “Microchip AR Configuration Utility” on the desktop again, and choose 

“Manual Setup” 

 

 

Figure 175  Manual setup  
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8. It will show below picutre that let you click the plus to calibrate touch panel. 

 

 

Figure 176  Click the plus to calibrate touch panel  
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9. After touch all the pluses , when it will show below picutre means  you can close application 

and complete the calibration. 

 

 

Figure 177  Complete the calibration 
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